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Q2QConnect Manual VARC Solutions

Welcome

Thanks for your purchase of Q2QConnect by VARC Solutions. Q2QConnect is the only tool of its
kind to quickly connect Quickbase to QuickBooks Desktop (Pro, Premier, or Enterprise
Solutions).

In this manual, we'll walk you through installation, connecting, and configuring Q2QConnect to
sync the available lists and transactions you want. Also included are FAQs, Tips, and Best
Practices to help you set up your Quickbase application like a pro!

We also acknowledge that some folks might feel more comfortable having our developers do
the work for you, which we are happy and standing by to do. If you’d prefer us to get things set
up and working for you, please call our sales team at 281-412-6914 and we’ll get a developer
assigned to do the work.

Overview
Q2QConnect helps you sync the following transactions between Quickbase and QuickBooks:
e Estimates
e Sales Orders
e Invoices and Invoice Paid Status
e Credit Memos
e Payments
e Purchase Orders
e |tem Receipts
e Bills, Bill Paid Status, and Bill Credits
e Credit Card Charges and Credit Card Credits
e Timesheets
Transactions are synced FROM Quickbase TO QuickBooks, and relevant information is
reported back to Quickbase to keep things organized. Fields that are written back to
Quickbase are indicated in Red on the transaction mapping screens. See Mapping section of
this manual for more information.

Q2QConnect helps you sync the following lists between Quickbase and QuickBooks:
e Customers
e Vendors
e Items
e Employees
Customer and Vendor lists are synced FROM Quickbase TO QuickBooks. For Items and
Employees, you can choose which direction the sync will flow.

PRO TIP: For accounting purposes, we recommend syncing Items and Employees FROM
QuickBooks TO Quickbase.

Page 1 © Copyright 2024 VARC Solutions. All Rights Reserved.
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Installation

Let’s get Q2QConnect installed! To ensure things run smoothly, please complete the installation
steps in the following order. You will need to be logged into a computer with Administrator rights.
Then, follow the installation steps below:

Preparing for Install
In order for Q2QConnect to establish a connection with your Quickbase app, you'll need to
create an application token. Don’t let that scare you, we’ll walk you through the process.

Create Quickbase Application Token
1. Sign in to your Quickbase application as a user with admin privileges.
2. Click the Home button.
3. Click the Settings gear icon.

N < a8 8 i}

Home Users Clients Vendors Employees

E Larry's Landscaping - C-Level Dashboard

4. Click App properties.

5. Click the Manage Application Token link below Advanced settings: security options.
+ Advanced settings

Sandbox Enable change management through a dedicated sandbox
Schema changes must be made using a sandbox.

Options Hide the new/updated icons for all users

Limit the user picker's "Find more people” to finding users in the company who are not in the app.
Mormally, this command finds users in the app, company or account/realm.

Default View: | Auto 4 |(does not apply to admin users)

Security options Allow users who are not administrators to copy (normally unchecked)
Allow users who are not administrators to export data
Hide from public application searches (normally unchecked)

@ Require Ass an Tokooe (noro hecked) (what does this mean?)
Go to the age to assign a token to this application (only required for APl calls).

Click Create New Application Token.

Enter Q2QConnect in the Description field.
Click the checkmark next to OK to Copy.
Click OK.

Create New Application Token X

Description:  [@2QConnect |

00N

OK to Copy:

‘0K to Copy’ must be checked for token to copy to/from a sandbox

10. You’ll copy and paste the Application Token into Q2QConnect later in the installation process.
11. If you need to get back to the Manage Application Tokens page, repeat the steps above.

Page 2 © Copyright 2024 VARC Solutions. All Rights Reserved.
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Download the QuickBooks Desktop SDK and Q2QConnect Installation Files
1. VARC Solutions emailed you a link to the QuickBooks Desktop SDK (otherwise known as

w

Page 3

“QBFC13”) and the most recent version of Q2QConnect.

Click on the link in your email to access our ShareFile repository. Or visit
https://tinyurl.com/g2qconnect-current

Click Select All.

Click Download.

T Q2QcConnect Public Installer-Current Release
Select A Sort B
e
|
QBFC 13 Install Q2QConnectv3.23.zip
o tems Selected Download-b

Click to open the Files.zip file in your downloads folder. (Depending on your operating
system, you may need to double-click on Files.zip to open the downloaded zip file.) You
should now see a QBFC 13 Install File and a Q2QConnect zip file.

“ Home Share View Extract
“ + 4 | L » ThisPC » Downloads » Files.zip
¢ Favorites ol o
Bl Desktop QBFC 13 Install
@ Downloads |, Q2QConnectV3.23.zip
& OneDrive
=, Recent places

Select and drag both files to your desktop for easy access.

© Copyright 2024 VARC Solutions. All Rights Reserved.
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Install the QuickBooks Desktop SDK (QBFC 13)
1. Double-click on the QBFC 13 Install file.
2. Double-click on the qbsdk130.exe file.
3. Click Yes several times (as many times as necessary) until the QuickBooks SDK13.0 —
InstallShield Wizard appears.

78 QuickBooks SDK 13.0 - InstallShield Wizard X

4. Click Next several times (as many times as necessary) until the installation copies the
files and finishes installation.

5. Click Finish.

6. You can safely close any Getting started window that opens after installation.

Page 4 © Copyright 2024 VARC Solutions. All Rights Reserved.
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Q2QConnect Installation

At this point, you are ready to install Q2QConnect with the previously downloaded Q2QConnect
installation zip file. The Q2QConnect installation file should be on your Desktop.

Multi-User Installs (V 3.25 and newer)
For multi-user installs of Q2QConnect, you’ll complete the installation and licensing steps on
each computer. We'll alert you to specific multi-user steps to complete as you go.

Install Q2QConnect
1. Double-click on the Q2QConnect installation zip file on your desktop. Another window
will open.
2. Double-click on the Q2QConnect installation file in the window that opens.
3. Double-click on the setup.exe file.

Name

Iey CommonAppData
ey VARC Solutions

B | setup.exe

» C'xCdC@.lnik

» | Setup.ini
ECJCCGnnect.nm

4. Click Yes until the Q2QConnect — InstallShield Wizard appears.

5. Click Next.

6. Click Install.

7. Click Yes (if prompted).

8. Click Finish.

9. The installer will add a Q2QConnect program icon on your desktop.

Recycle Bin

10. At this point, you can safely delete the downloaded zip and install files.

Page 5 © Copyright 2024 VARC Solutions. All Rights Reserved.
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Configuring Q2QConnect

Nicely done! Now that Q2QConnect is installed, it’s time to get the application configured and
activate your Q2QConnect license.

Open QuickBooks
1. Open QuickBooks as normal and open your desired QuickBooks company file.
2. Login as an Admin user.
3. From the File menu, select Switch to Multi-user Mode.
Launch Q2QConnect and Request License
1. Switch to your desktop and double-click on the Q2QConnect program icon.

2. Enter your name, company name, and email address in the Q2QConnect License Status
window.

3. Click Request License. This sends an email to VARC Solutions to grant your license. This can
take up to 1 business day. To expedite, call VARC Solutions at 281-412-6914.

>

O2QC#%#:NNECT

License Status None

#] License Status

Your Name |Brad White
Company Name |Acme Test Co

Email Address  |bradstest @varcsolutions com

: Request License {
L

License Code

License will be installed for user name: Brad White

4. Your license status should now show as Pending.
5. Once your license has been granted, you will receive an email confirmation.
6. After receiving email confirmation, click the Refresh button on the License Status window.

#)| License Status - X

Q2QC%:NNECT

ense Status Pending

Your Name |Brad White
Company Name |Acme Test Co
Email Address |brad+test@varcsolutions com

Request License

License Code

License will be installed for user name: Brad White

Page 6 © Copyright 2024 VARC Solutions. All Rights Reserved.
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7. Your License Status should change to Granted, and your License Code should
automatically populate.

[#®)] License Status — -

Q2QC#:NNECT

Your Name |Brad White |

Company Name |-°«crne Test Co |

Email Address |brad-te§ @varcsolutions com |

Configure License

License will be installed for user name: Brad White

8. Click Configure License.

Establish Q2QConnect Connection Settings

You are almost home! Now that Q2QConnect is installed and your license has been granted, it’s
time to establish your connection settings. This is where you’ll get Quickbase and QuickBooks
talking to one another!

)| Connection Settings - x
] g

@ Singleuser (O Multiuser  Config File Path  C:\VARC Sclutions'\Q20Cannect \(20sattings co

Q) Realm |varcsclutions quickbase com !

Email Address or Screen Name |brad@varcsolutions .com

EASE passwor

Connect to Quick Base

Connect and |
Select Your Quick Base
{or Enter it below)

QuickBase Application Name |Larry's Landscaping

Database ID |bmgBk Zbmy Test Connection
Application Token P |

1 1. Launch Guick Books, open your company file, and login as Admin
QuickBooks G e T non
3. When the Cuick Books - Access’ window opens:

Connection T a.select Yes, always; allow access even ff Guick Books is not running”
e b. next to the “Login as:' prompt, select "Admin’
Local ot c. click Continue...”
4. In the Confirm to Proceed’ window, click Yes’
Open Mode 5. In the "Access Confimation’ window, click "Done’
MultiUser I Connect to cumently open GuickBooks company file i

QGuickBooks Company File Path |C:'-|J=efs ‘\Public\Documents ntut \Guick Book s\ Sample Company I|
QuickBooks Company Name Rock Castle Construction Test Connection

License Granted To: Acme Test Co

Install License k_]

Page 7 © Copyright 2024 VARC Solutions. All Rights Reserved.
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Configuration: Single-user vs Multi-user
1. Single-user Configurations:
a. Select Single-user. Continue to Configuration: Quickbase Section below.

2. Multi-user Configurations (V 3.25 and newer):
a. Forthe FIRST user being configured:

Page 8

Select Single-user. You will change the setting to Multi-user later. Continue to
Configuration: Quickbase Section below.

b. For subsequent users:

Select Multi-user.
Click the [-| button to browse to the shared network folder where configuration
settings are stored.

Click OK.

Click Yes when prompted to copy the configuration settings. The rest of the
connection settings should be populated for you.

Q2QConnect ILI

Do you want to load the settings from the existing Q20Connect settings file
located in 'Q:\C2Q Data Files\0D Q2Q Cenfig File'?
This file was last modified 4/23/2020 2:31:11 PM

| Yes | | Mo |

Click Test Connection on both the Quickbase and QuickBooks sections.

Click Install License.

Accept the License Agreement and click OK.

Click OK.

Exit Q2QConnect.

At this point, you will skip the remaining configuration steps and proceed to the
instructions for Connecting and table/field Mapping if that hasn’t already been
completed.

© Copyright 2024 VARC Solutions. All Rights Reserved.
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Configuration: Quickbase Section

This needs to be completed by a Quickbase Admin user with full access to all tables within
your application. For example, they need to be able to add and modify fields.

1. Enter your Quickbase Realm. For example, when you login to your Quickbase
application, the Realm will be something like the bolded text here:
https://varcsolutions.quickbase.com/db/bmg6k2bmy

2. Enter your Quickbase login Email Address or Screen Name and Password. This can be
changed later as needed.

3. Click Connect to Quickbase and select from the list of available applications.
- X

#)| Connection Settings

@ Singleuser () Mutiuser  Config File Path

Q) Realm |varcsclutions quickbase com

Email Address or Screen Name  |brad @varcsolutions.com
Password |=********
Connect to QuickBase
Connect and | Lamy’s Landscaping [N

Select Your Quick Base

{or Enter it below)

QuickBase Application Name |Lamy’s Landscaping
Database ID  |bmgBk Zbmy Test Connection

Application Token

4. Next, copy and paste your Application Token from Quickbase. The application token
should have been created earlier in the Preparing for Install steps.
5. Click Test Connection.

QuickBase Connection X

Test connection successful,

Note: Q2QConnect is currently not compatible with Quickbase 2 Step Authentication. If
necessary, disable 2 Step Authentication in your realm/policy or account settings. Learn how
to enable/disable here: https://help.quickbase.com/user-assistance/two_step_auth.html

Page 9 © Copyright 2024 VARC Solutions. All Rights Reserved.
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Configuration: QuickBooks Section

You should already be logged into your desired QuickBooks company file as an Admin user, in
Multi-user Mode.

1. Click Connect to currently open QuickBooks company file. QuickBooks should open a

QuickBooks — Application Certificate window.

a. If this window is accidentally closed, you can find it again by switching to QuickBooks
in Single-user Mode, and selecting Edit > Preferences from the menu. Click
Integrated Applications. Click the Company Preferences tab. Select Q2QConnect
and click Properties or Reauthorize.

2. Click Yes, always; allow access even if QuickBooks is not running.

Yes, whenever this QuickBooks company file is open will also work if you prefer.

3. Click Allow this application... to provide sufficient rights for Q2QConnect to sync data
with QuickBooks.

An application is requesting access 1o the following QuickBooks company file

Access may include reading and modifying QuickBooks data as well as
enhancing the QuickBooks user interface (where applicable)

THE APPLICATION CALLS ITSELF
Q2QConnect

CERTIFICATE INFORMATION
Description.  Connecting YOUR QuickBase and QuickBooks
Developer VARC Solutions LLC
Developer identity has been venfied by
Symantec Class 3 SHA256 Code Signing CA

i

{E )

QUICKBOOKS SOLUTIONS MARKETPLACE

eam about apf atio at integrate with QuickBooks

Do you want to allow this application to read and modify this company file?
™ No
™ Yes, prompt each time

Yes._whenever this QuickBooks company file is open
® Yes, always, allow access even if QuickBooks is not running

7 Allow this apphcation to access personal data such as Social Security Numbers and customer
credit card information

Continue... k Cancel Help

4. Click Continue.
5. Click Done (if prompted) in the Access Confirmation window.
6. Click OK.

Q2QConnect b4

QuickBooks connection successful.

Page 10 © Copyright 2024 VARC Solutions. All Rights Reserved.
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7. Click Install License.

)| Connection Settings - X
ol g

@ Singleuser (O Multiuser  Config File Path  C:\VARC

annect L Adsettings co

Q) Realm |varcso||.mons quickbase com |

Email Address or Screen Name  |brad @varcsolutions .com |
SRIHHG i pr—
BASE Password %
Connect to QuickBase
Crncta Y N . |
Select Your Quick Base
{or Enter it below)

QuickBase Application Name |Lamy’s Landscaping

Database ID  |bmgk Zbmy Test Connection
Application Token & uw -

1 1. Launch Guick Books, open your company file, and login as Admin
QUIckBOOkS ; Grttomms ot

3. When the Quick Books - Access’ window opens:

Connection T a.select Yes, always; allow access even f Quick Books is not running”
dlidiig b. next to the "Login as:' prompt, select "Admin’
Local 5 ¢. click Continue.."
4. In the Confirm to Proceed’ window, click "Yes’
Open Mode 5. In the "Access Confimation’ window, dlick ‘Done’
MultiUser . Connect to cumently open Guick Books company file i

Guick Books Company File Path |C:'-Usefs ‘\Public\Documents Intuit \Quick Book s\ Sample Company I|
GuickBooks Company Name Fock

iction Test Connection
License Granted To: Acme Test Co
| Install License \_J

8. Review the Q2QConnect License Agreement, and select | accept the terms of the
license agreement.

License Agreement x

Software License

VARC Solutions hereby grants Customer a nonexclusive license to use one copy of
the software listed in Schedule "A’ hereto ithe "Software’) for use on a single computer
ffior the sole purpose of transfeming data from a single Guick Base application to a
single Quick Books company file. Customer may make one backup copy of the
Software for their own use. Making additional copies is prohibited. Giving copies to
lanother person or duplicating the Software by any other means, including
transmission, is also prohibited. Customer may not copy the printed matenials
laccompanying the Software or print copies of the user documentation. The Software
is protected by copyright law, and title to the Software shall at all times remain
exclusively with VARC Solutions. The Software also contains VARC Solutions trade
secrets, and Customer may not reverse engineer, decompile, disassemble, or
otherwise reduce the Software to human-perceivable form. Customer may not modfy,

~

(@) | accept the temms of the license agreement.
() 1 do not accept the terms of the license agreement.

e | 5]

9. Click OK
10. Finally, call VARC Solutions at 281-412-6914 to request activation prior to using the

application. Once VARC Solutions confirms your activation, you can launch Q2QConnect,

connect Quickbase and QuickBooks, and proceed with the mapping process.
Q2QConnect b4

The license was installed successfully, but is not yet activated
for use.

Please contact VARC Solutions at 251-412-6914 to request
activation prior to using the application.

Page 11 © Copyright 2024 VARC Solutions. All Rights Reserved.
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Multi-User Configuration (V 3.25 and newer)

At this point, you have installed and licensed Q2QConnect for your first user, however the
configuration is set for Single-user. If you purchased a multi-user license, you need to enable
the multi-user configuration.

1.

w

o

Create a shared network folder, with full read/write access, where the Q2QConnect

configuration files can be stored and accessed by your desired users.

a. Make a note of the full path to this shared folder. The file path specified for all
installations needs to match. Example, if your configuration file path is
M:\<foldername or path> on one computer, the same path must be used on other
computers. If you specify a UNC path such as \\servername\path on one computer,
that same path must be used on other computers.

Select Settings > Database Connections from the menu.

Select Multi-user.

Click the [| button to browse to the shared network folder created in Step 1 above.

() Connection Settings =|0
Snngleuser Config File Path |C :
Click OK.
Click Save Settings.
Click Close.

At this point, you can either repeat the installation and licensing steps for subsequent users or
continue with connecting and mapping tables and fields as instructed below.

When you install Q2QConnect for subsequent users, the configuration and mapping will be
shared across all licensed users.

Page 12 © Copyright 2024 VARC Solutions. All Rights Reserved.
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Connecting Quickbase and QuickBooks

At this point, you have installed Q2QConnect and have an active license. Q2QConnect has
stored the Quickbase and QuickBooks information, along with your license so you won’t need
to enter them again.

When you are ready to use Q2QConnect, open the program using your Q2QConnect application
shortcut and click Connect.

1. Double-click the Q2QConnect application shortcut on your desktop.
2. Click Connect. This will initiate a connection to Quickbase and QuickBooks.

m | % @ B i L} 5) ]

b 2 L] ] ] L7 & = @ Q hd =) |
Connect | Customers = Vendors ftems | Employees | Estimates  Sales Orders | Invoices  Invoice Paid Status | Credit Memos ~ Payments | Purchase Orders | Receipts Bills  Bill Paid Status | Bill Credits  Credit Card Charges  Credit Card Credits  Timesheets | Send Selected

Customer Search [ || From [5/ 17200 @] (To [ 22020 §-] | SelectAll | Unselect All |

Books: Not connected

NOTE: When Quickbase and QuickBooks are connected, the Base and Books indicators on the
bottom of the screen will show the connections in green.

File Settings Help
= =

o 2 & o] 7 & = @ e © =) [ ] @ B B ch 9] j
Connect | Customers | Vendors | ltems | Employees | Estimates | Sales Orders | Invoices | Invoice Paid Status | CreditMemos | Payments | Purchase Orders | Receipts | Bill: | Bill Paid Status | Bill Credits | Credit Card Charges | Credit Card Credits | Timesheets | Send Selected

View | v lcusomersemch|||Fom [37 4200 B-] | To Select All | Unselect Al

PRO TIP: If you right-click on the bottom row of Q2QConnect that shows Base and Books, you
can individually connect or disconnect Quickbase or QuickBooks as needed.

File Settings Help

o 13 L]

B = ® = @ © © | @ J & =] ) 2] 4
Connect | Customers = Vendors = Items | Employees | Estimates = Sales Orders | Invoices | Invoice Paid Status | CreditMemos | Payments | Purchase Orders | Receipts | Bills  Bill Paid Status | Bill Credits | Credit Card Charges | Credit Card Credits | Timesheets | Send Selected

View. ~| | Customer Search |From [ 5/ 42020 B-]|To [ 51172020 B- | Select All | Unselect All

Connect ---> Base
Disconnect --X-- Base

Connect ===> Books

Base: 020 Testing App 2020 N1 Books: Lary’s Landsceping Gerden Supply |

Page 13 © Copyright 2024 VARC Solutions. All Rights Reserved.
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Mapping

Mapping is the process of defining which QuickBooks fields correlate to matching tables and
fields in Quickbase. Without mapping, Q2QConnect won’t know where to get or send the
information.

As an example, on the QuickBooks Customer:Job list, there are Company Name, Phone
Number, Email Address, and Bill To/Ship To Address fields. Which Quickbase table stores
customers? And which fields in that table should be linked to name, phone, email, and address
fields in QuickBooks? Welcome to mapping!

The following diagram shows mapping of the Client Name in Quickbase to the Customer Name
in QuickBooks.

Quick Base: Clients Table
£ ettings 5 Fields Tlmporl/Expon

 Exit Settings

Table Structure i Show AR T Tl Advanced Options

QuickBooks
"® Ly Landscaping & Garden Supply - Intuit GuickBaoks Enterprise Solutions: Accountant 20, 0(multi-userfAdmin) ~ — 1 %
File Edit View Lists Favorites Accountant Company Customers Vendgrs Employees [nventory Banking Reports Window Help

Structure

I Fields I

% Delete

Table-to-table relationships @ Field Label

A © B € & T W & B B’ T
g Q2Q- Customer Name

Home My Company Calendar | Snapshots Customers Vendors Emplovees BankFeeds Docs Reportt

Advanced settings

QZQCOFIrIeCt How do | adjust the current balance? CURRENCY US Dollar -8
e = &
. Lls‘Fle'd M 2 £ Abercrombie, Kristy
Customer | Vendor | kem | Employee, Kristy " (WL |Apercrombie

Direction of data transfer. Quicliese —> QuickBooks Sales Ta

Pick Number of Levels ¥ Show detais MainPhone - |(415)555-6579 Main Email  ~

e Boes Table: Work Phone  ~ CC Email x

Gierts ] Level 1 Mobile - Website -

Frojecis [v|Level 2 = = Fr— =

ADORESS DETAILS
* Ared label indicates the data s =
it Abercrombie, Kristy
Clents [Projects [ I | Abercrombie, Kristy ¢ &
Kristy Abercrombie Copy »>

Quick Base Field ; Bayshore, CA94326

—————————
E (G20 Customer Name [ Customer Name 1

R Cortone Tane e e

Q20 Customer Type v | Customer Type it

G20 Address Line 1 | Address Line

Q2QConnect makes it easy to map the available lists and transactions you plan to sync. And this
mapping process only needs to be completed one time. However, if you make changes to your
Quickbase application, or start using additional fields later, you can update your field mappings
at any time.

e First, we'll show you how to map your lists

e Then, we’ll show you how to map transactions

e Lastly, we’ll help you avoid some of the more common mapping mistakes and share
some mapping best-practices.

Refer to the individual list or transaction to see a complete list of fields you can map in
Q2QConnect.

Page 14 © Copyright 2024 VARC Solutions. All Rights Reserved.



Q2QConnect Manual

VARC Solutions

General Mapping Instructions
1. Click Settings > Maps — Lists or Maps — Transactions from the menu.

Filters - Transactions

o
File [ Settings | Help
& ] Data-base Connections
Connef Choose Lists/Transactions
View _ Mrzp_s - Lists %
Maps - Transactions
Filters - Lists

2. Each tab represents a |

ist or transaction. Select the appropriate list or transaction tab to map.

3. Click the Quickbase Table drop-down list and select the appropriate table that
corresponds to the list/level in QuickBooks.

Customer | Vendor | kem | Employee

List Field Mapping =]

Direction of data transfer: QuickBase —> QuickBooks

Pick Number of Levels

[v] Show detais

4. Click Save Tables / Reset Field Names.

Pro Tip: When mapping lists and transactions, click the Show details box. Later, when
transferring data between Quickbase and QuickBooks, Q2QConnect will show the
information being exchanged in detail.

Customer ._ Vendor ] ftem | Employee |

Pick Number of Levels

= List Field Mapping [x7]]

Direction of data transfer: QuickBase —> QuickBooks

[v] Show details

QuickBase Table
Clients v |Level 1
Projects [v|Level2

Save Tables / Reset Field Names |

* A red label indicates the datais
updated from Books to Base

Page 15
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5. For each field you want to map between Quickbase and QuickBooks, click the Quickbase
Field drop-down list and select a matching field. Pro Tip: We suggest creating Q2Q
formula fields to easily change data without having to remap fields later.

= List Field Mapping

Customer | Vendor ] ftem l Employee |

Direction of data transfer: QuickBase —3> QuickBooks
Pick Number of Levels [2 vJ [V Show details

QuickBase Table
Clients

Level 1
Level 2

<

<

Projects

* Ared label indicates the data is

[[Save T £ Field Names updated from Books to Base

Clients Projects ] ] I
GuickBase Field QuickBooks Feld =
Q2Q Customer Name v | Customer Name .
Q24 Customer Name w | Company Name i)
Q24 Customer Type w | Customer Type &
(Q2Q Address Line 1 v | Address Line1
v

skl Address Line3
Address Lined

Q2Q Address Line 4

Q2Q City City

Q2G Compary Name

Q2Q Country State/Province

Q2Q Curency Zip/Postal Code

G2Q Customer Name p

Q23 Customer Type Country/Region

Q2Q Email =—— v
|Q2Q Fax

|Q2Q First Name

Q20 Is Active s Save & Close

6. Click Apply Changes or Save & Close.

Pro Tip: It's not necessary to map every field between Quickbase and QuickBooks. However,
there are some REQUIRED fields. See the particular list or transaction page in this manual
for a list of required fields.

Mapping Lists
Let’s get your lists mapped! Follow the general mapping instructions on Page 15. Then, refer to

this section for specifics about each list.
=l List Field Mapping

CUStOITIEf _Vendorl tem I Emplayee |

In this section, we’ll cover mapping the following lists:
e Customers
e Vendors
e |tems
e Employees

Remember: To start mapping lists, open Q2QConnect, click Connect, then click Settings > Maps
— Lists from the menu. Fields shown in Red font are written back to Quickbase. Refer to the
individual list to see a complete list of fields you can map in Q2QConnect.
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Customers
For Customers, you need to specify the number of levels that you have in QuickBooks;
Customers, Jobs, Sub-Jobs, etc.

You can map up to 5 customer levels, however we recommend keeping it simple and mapping
only up to 2 customer levels. For example, if you have customers AND jobs in QuickBooks,
select 2 Levels.

Customer  (Level1l) Example: Acme Co

Job (Level 2)  Example: Acme Co: Acme Telephone

Next, for each table/level, map specific fields between Quickbase to QuickBooks.

QuickBooks Required Fields:
e (Customer Name
Fields That Are Written Back to
Quickbase:
e Open Balance
[T Pl | stz e
Cients | Projects | | I |

QuickBase Field QuickBooks Field

Q2Q Customer Name v | Customer Name

Q20 Customer Name v | Company Name

Q2Q Customer Type v | Customer Type

Q2Q Address Line 1 v | Address Line1

Q20 Address Line 2 w | Address Line2

Q20 Address Line 3 v | Address Line3

Q20 Address Line 4 w | Address Lined

Q2Q Ciy v|cty

Q2Q State w | State/Province

Q2Q Zip v | Zip/Postal Code

v | Country/Region

Q2Q First Name + | First Name

Q20 Last Name w | Last Name

Q2Q Job Title w | Job Title

Q20 Phone w | Phone

Q20 Fax v |Fax

Q2Q Email v | Emai

Q2Q Currency v | Curency

Q2Q Account Number v | Account Number

Q2Q Terms v | Terms

Q2Q Tax Code v | Tax Code

Q2Q Tax kem v | Tax tem

Q2Q Resale # v | Resale No

Q2Q Sales Rep nitals v | SalesRep Initals

Q2Q 0K To Send v| OkToSend

Account Balance v | Open Balance

Q20 Is Active v | lsActive

| Cancel || PeplyChanges || SavedClose |

Page 17 © Copyright 2024 VARC Solutions. All Rights Reserved.



Q2QConnect Manual

Customer Mappable Fields (Level 1)
The following highlighted QuickBooks fields are mappable to Quickbase:

Address Info Tab

=2

Edit Customer

cusTomER Nave Abercrombie LLC

CURRENT BALANCE 4,649.85

Address Info

How do | adjust the current balanca?

VARC Solutions

| Customer is inactive

comrany name | Abercrombie LLC
Payment Settings F AME | M ke_lly
Sales Tax Seftings L
Main Phone ~ (281)412-6914
Additional Info
Work Phone ~
Job Info Mobile -
Fax ¥
ADDRE 55 DETAILS
INVOICE/BILL TO
Abercrombie LLC ﬁ,

Abercrombie, Kristie P 906 Anna
Friendswood, TX 77546

Copy »>

Clark

Main Email
CC Email
Website

Other 1

Fitch@abercrombie.com

o

Cancel Help

Payment Settings Tab
=
custouer nave Abercrombie LLC
NCE 464985
RQUIESS Info ACCOUNT NO

Payment Settings
PAYMENT TERMS

Sales Tax Settings PREFERRED

DELIVERY METHOD

Edit Customer

How do | adjust the current balance?

1167119

None

Sales Tax Settings Tab

= Edit Customer

Additional Info

= Abercrombie LLC
u CE 464985
Address Info —
Payment Settings e N
Sales Tax Settings
RESALE NO

How do | adjust the current balance?

Tax

Out of State

Page 18

Additional Info Tab

= Edit Customer|

vz Abercrombie LLC

NCE 4,649.85 How do | adjust the current balai
Address Info
CUSTOMER TYPE

Payment Sefings

REP
Sales Tax Seftings

Additional Info
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Job Mappable Fields (Level 2-5)
In addition to the standard customer mappable fields, he following highlighted QuickBooks Job
fields are mappable to Quickbase:

QuickBooks Required Fields:

oz nave | Job 1 e Job Name

a5 OF 04/22/2020 B How do | determine the opening balance?
b - Fields That Are Written Back to
Payment Settings fidh s g QUiCkbase:

Additional Info e Open Balance

Trus | None -

Job Info

Pro Tip: If IsActive is mapped on the Customer level, it must be mapped at each lower level.
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For Vendors, there is only 1 table level to map. In the example below, we are mapping the
Vendors table in Quickbase to the Vendors list in QuickBooks.

[ Customer | Vendor | kem | Employes |

QuickBooks Required Fields:
e Vendor Name

Fields That Are Written Back to

Quickbase:

e Open Balance

Direction of data transfer: QuickBase —> QuickBooks

QuickBase Table V] Show details

QuickBase Field QuickBooks Field

Q2Q Vendor Mame v | Vendor Name

Q2Q Company Name v | Company Name

Q20 Vendor Type v | Vendor Type

Q2Q Address Line 1 v | Address Linel

Q2Q Address Line 2 v | Address Line2

Q2Q Address Line 3 v | Address Line3

Q2Q Address Line 4 v | Address Line4

Q2Q Ciy v | Ciy

Q2Q State v | State/Province

Q2Q Zip/Postal Code v | Zip/Postal Code
w | Country/Region

Q2Q First Name + | First Name

Q2Q Last Name w | Last Name

Q2Q Phone w | Phone

Q2Q Fax w | Fax

Q2Q Email w | Email

Q20 Cumency v | Cumency

Q2Q Account Number v | Account Number

Q20 Tems v | Terms

Q2Q Print On Check As | Print On Check As

Q2Q Tax ID v | Tax 1D

Q2Q Ehgible for 1099 + | Eligible For 1099

Q2Q OK To Send v | Ok ToSend

Open Balance v | Open Balance

Q20 Is Active v|isActive

| Cancel || ApplyChanges ||  Save&Cise
Page 20
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The following highlighted QuickBooks fields are mappable to Quickbase:

Address Info Tab

= Edit Vendor - 0 X
vENDOR HaveE AutoWorks United
CURRENT BALANCE 1,100.00 How do | adjust the current balance?
Address Info compaNY NaMe | AutoWorks United
Payment Seftings FULL NaME | Mr/Ms./.| [im 1. Blanchard
Tax Settings 3 g g
Main Phone ~  (415) 555-8965 MainEmail ~ Jim1@autoworksunited.com
Account Settings "
Work Phone  ~ CC Email -
Additional Info Mobile - Website -
Fax +* | (415) 555-8966 Other 1 v
ADDRESS DETAILS
BILLED FROM FFED FRO
AutoWorks United
270 Old Bayshore Rd 4 ¢
Bayshore, CA94326 Copy >>
USA
_| Vendor is inactive “ Cancel Help
Payment Settings Tab

= Edit Vendor

VENDOR Naus AutoWorks United

CURRENT BALANCE 1,100.00 How do | adjust the current balance?

dkdsss i ACCOUNT NO -DE-091B

Payment Settings ervuent erus I a o

Tax Settings PRINT M

NAME ON

Account Settings

Tax Settings Tab

= Edit Ven

venpor nave  AutoWorks United
CURRENT BALANCE 1.100.00 How do | adjust the current
Address Info

TAX INFORMATION
Payment Settings
ENDOR TAX ID
Tax Settings
‘Vendor eligible for 1099

Account Settings

Page 21

Additional Info Tab

= Edit Vendor

ENDOR Nave  AutoWorks United
CURRENT BaLANCE 1,100.00 How do | adjust the current balg
Address Info

ENDOR TYPE >

Payment Seftings
Tax Seftings
Account Settings
Additional Info
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ltems
For Items, you need to specify the number of levels that you have in QuickBooks; Items, Sub-
Items, etc.

You can map up to 5 item levels, however we recommend keeping it simple and mapping only
up to 2 item levels. For example, if you have Item and Sub-Items in QuickBooks, select 2 Levels.

(Level 1)
(Level 2)

ltem Example: Trees

Sub-ltem Example: Trees: Fruit

Q2QConnect also allows you to choose which direction data will transfer for Items; Quickbase
to QuickBooks or QuickBooks to Quickbase.

We recommend transferring data from QuickBooks to Quickbase for items to preserve the Item
account mapping correctly in QuickBooks.

In the example below, we are mapping the QB Items (child) table in Quickbase to the Items list

in QuickBooks.

Cn.u&onm]‘u"eﬂdu ltem Ermloyoe

Direction of data transfer: § QuickBase (

List Field Mapping

) «<— (® GuickBooks

Sales AND Purchase
Sales ONLY
Mapped (below)

BMS

v W

Save Tables / Reset Field Names

T ERTE

* Ared label indicates the data is
updated from Books to Base

QuickBooks Required Fields:
e |tem Name
e |tem Type

Fields That Are Written Back to

Pick Number of Levels |2 bl Eﬂ Show details Quickbase:
s e Qtyon Hand
QB tems v |Level 1

Note: In our Best Practices section of this
manual, we suggest creating Q2Q Formula
Fields, and mapping lists to those fields.
However, when the direction of transfer is

Page 22

QuickBase Field QuickBooks Field
s oy P set from QuickBooks to Quickbase, you
kem Type v hem Type need to map to writeable, non-formula
ol YL P fields, as shown to the left.
Load Reimbursable w | Reimbursable
Sales Description v | Sales Description
Sales Price v | Sales Price
Purchase Description v | Purchase Description
Purchase Frice v | Purchase Cost
Load Prefemed Vendor w | Preferred Veendor
Asset Account w | Asset Account
Income Account v | Income Account
COGS Account v | COGS Account
OK To Send v | Ok ToSend
Gty On Hand v | Gty On Hand
Active Checkbox v | IsActive
Cancel || AoplyChanges ||  SavedClose
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Item Mappable Fields

The following highlighted QuickBooks fields are mappable to Quickbase:

Service Item Fields

=
TYPE
fees.
Item Name/Mumber Subitem of
Design

UNIT OF MEASURE

Enable...

PURCHASE INFORMATION

Description on Purchase Transactions

Edit Item

. Usefor senices you charge for or purchase, like
specialized labor, consulting hours, or professional

& This semvice is used in assemblies or is performed by a subcontractor or partner

SALES INFORMATICN

Description on Sales Transactions

==
Cancel
Notes

Custom Fields
Spelling

Edit Markup...

[ ltem is inactive

x

Design Design
Cost 55.00 Sales Price 70.00| Markup 27.27%
Expense Account  Subcontractor Labor w | TaxCode Non Margi: 21435
Preferred Vendor | Construction andMore ~  IncomeAccount |Instaliation Services =
How can | set rates by customers or employees?
Inventory Part Fields
= Edit Item - B0 %
g [ o |
Inventory Part » Useforgoods you purchase, track as inventory, and resell.
Cancel
New Note
ltem Name/MNumber Subitem of Manufacturers Part Number
TR — Custom Fields
Sprid pipes - SPR-PP-09B

UNIT OF MEASURE

Enable...

PURCHASE INFORMATION

Description on Purchase Transactions

Plastic sprinkler piping #1098-20

Cost 210
Landed Cost nia
COGS Account Materials Costs >
Preferred Vendor | House Supplies ofAm... ~
Alternate Vendor Manage
INVENTORY INFORMATION

Reorder Point
AssetAccount (Min) Max

Inventory Asset

SALES INFORMATION
Description on Sales Transactions

Sprinkler pipes
Sales Price [ 2.?5:
Tax God — Markup 30.95%
95 -one Jax Margin 23.64%
Income Account  Parts Sales -

OnHand “Ver38  OnPO. On Sales Order
Cost
300 210 50 54

Spelling

Edit Markup...

Item is inactive

Page 23
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Employees

Q2QConnect also allows you to choose which direction data will transfer for Employees;
Quickbase to QuickBooks or QuickBooks to Quickbase.

We recommend transferring data from QuickBooks to Quickbase for Employees to ensure
Earnings and other important employee details in QuickBooks are properly set up and
maintained.

In the example below, we are mapping the Employees table in Quickbase to the Employees list in
QuickBooks.

List Field Mapping =] QuickBooks Required Fields:
[ Customer | Vendor | tem | Employee | _ e Base to Books:
Diection of data bansfer: e At least one of the name fields
OuickBase Table [Enployees v] M Show detas (First Name, Middle
i SEhFaks Pl = Name/Initial, or Last Name)
First Name W | First Name |
Middle Iniial v | Middle Name |
Last Name v [Last Name If the QuickBooks Employee List
Print on Check As v | Print On Checks As . . o
— o e | includes Middle Initial data, then
Gender v | Gender i you need to map the middle initial
DoB v | Date of Birth field
US Cizen v | US Ctizen *
Ethnicity v | Ethnicity
ek v | Fields That Are Written Back to
Diisability Desc v | Disability Desc .
19.0n Fie v |1-90n Fie | Quickbase:
'Work Auth Exp Date v | Work Auth Bxpire Date ° (none)
US Veteran v | US Veteran |
Military Status v | Military Status .E
Address: Swredt | | Addess Ui Note: Payrates can’t be imported into
Address: Street 2 v | Address Line2 .
ey i | QuickBooks. They must be manually
Address: Siste/Region v |[sise _ updated in QuickBooks.
Address: Postal Code v | Zip |
Phone v | Phane |
Enai v Emai ! In our Best Practices section of this
i i e i manual, we suggest creating Q2Q Formula
Primary Contact Phone v | Primary Contact Phone . . . .
Primary Contact Relation | Primary Cortact Relation Fields, and mapping lists to those fields.
Secortay Cortact v | Secondary Contact Name | However, when the direction of transfer is
Secondary Contact Phone v | Secondary Contact Phone . .
Seconday ortact Relaion || Seconday ortact Relaton | set from QuickBooks to Quickbase, you
Account # v | Account Number | need to map to writeable, non-formula
Hre Date v | Hire Date | .
S 5 e | fields, as shown to the left.
Employmert Type v | Employment Type |
Ful/Part Tine v | Full/Part Time i
Exemat v | Exempt |
Key Emgloyee v | Key Employee |
Job Tile v | Job Tile
Supervisor v | Supervisor |
Department v | Department |
Job Description v | Job Description
Target Bonus + | Target Bonus
'OK To Send v | OkToSend
Active v | IsActive
| cacel || ApplyChanges || Save&Cose |
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Employee Mappable Fields

The following highlighted QuickBooks fields are mappable to Quickbase:

Personal Tab

VARC Solutions

= Edit Employee -0 %X
eorusTion Eor Alexandra Hall
Personal
NAME | MM Alexandra M. Hall
Address & Contact
Alexandra Hall DNSERLEX
o S DisaBLED |No *
Additional Info 012-34-5678
DISABILITY DESCRIFTION
Payroll Info cenper  Female -
B e i [P 1 13 FORM
Employment Info ATE OF BIRTH [01R05(1992 =
ON FILE |Yes -
MARITAL STATUS  Single -
WORK AUTHORIZATION [T i
38 v [Vea = EXPIRES
eTHNICITY | White - MILITARY
U.S VETERAN Mo -
STATUS -
Employee is inactive “ Cancel Help
Address & Contact Tab
= Edit Employee -0 %
NEDRUATION Eor Alexandra Hall
Personal HOME ADDRESS
Address & Contact ADDRESS | 4T75 W Panther Creek Dr
Apt 1019
Additional Info —
ciry | Spring
Payroll Info sTaTE (TX - ZIP '.'T381
Employment info =
MAIN FHONE | (415) 555-1234 MAIN EMAIL - alexandra@larrys.com
Work Phone ~ CC Email =
Mobile v Website v
Fax - Other 1 -
EMERGENCY CONTACT INFO
CONTACT PHONE RELATION
Craig Hall 281-555-1234 Father -
Robin Hall 281-555-2345 Mother -

Page 25
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Additional Info Tab

= Edit Employee

FoRIATION FOR Alexandra Hall

Personal

Address & Contact

Additional Info

Employment Info Tab
= Edit Employee

ForuaTIoN For Alexandra Hall

Personal
2 Employment Leave ofAbsence Termination

A.QCIIBSS & Contact EMPLOYMENT DATES JOB DETAILS
Additional Info HIRE DaTE | 04/04/2020 [E TITLE | Account Executive

AL HIRE DATE JPERVISOI R mi i
Payroll Info i surervisoR  Ron Smith

STED SERVICE DATE ] DEFARTMENT | Sales

Employment Info

RELEASE DATE B b

(LAST DATE ON PEYROLL)

EMPLOYMENT DETAILS

TARGET BONUS |0.00

EMPLOYMENT TYPE  Regular -
FULL/PART TIME | Fullime -
EXEWFT  Mon-Exempt b

KEY EMFLOYEE No -
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Structuring Your Quickbase Application for Mapping Transactions
Mapping transactions requires at little more planning and likely some updates to your Quickbase
application.

Quickbase is a relational database, which means it can relate tables together for greater efficiency and
data integrity. In practice, this means you wouldn’t have one table in Quickbase called “Invoices” that
contains all the information you need to transfer to QuickBooks. If so, you would see incredible
amounts of redundancy in the data, and dramatically increase the likelihood of data inconsistencies.

Consider the following example, where you are mapping a 3 line invoice. To accomplish this using a
single Quickbase table, in addition to the line item details of what you sold, each line would also
contain the customer name, address, invoice #, invoice date, customer terms, etc.

Instead, you would have a parent table named something like “Invoices” and a child table named
something like “Invoice Items”. The “Invoices” parent table would store the information that applies
to each line item (aka. header information), such as customer name, address, invoice #, invoice date,
customer terms, etc. The “Invoice Items” child table would store the line item details, such as the item
name, description, quantity, and price.

You would create a relationship between the “Invoices” and “Invoice Items” tables so that each line
item detail is associated back to the same “Related Invoice”.

Which Table Do | Map?

So, let’s assume at this point you’ve set up a parent Invoices table and a child Invoice Items table in
Quickbase. Which table do you use for mapping in Q2QConnect? The answer: you map the child
Invoice Items table.

It’s beyond the scope of this manual, but you’ll need to edit your parent/child relationship to add
“Lookup Fields” to your child table to pull header fields from the parent table into the child table. So,
even though you are mapping the child table, the parent table header information will be included.

n B"}nlnvoices Settings ~ Relationships Invoices .-{j Invoice ltems (Related Invoice)
x Exit Settings
@ Invoices JE Elnvome Items (Related Invoice)

Parent Table - Invoices | | Child Table - Invoice ltems
Field Field Type Field Field Type
Record ID# Record ID# Related Invoice Numeric (reference)

Invoice ltems Report Link Del nvoice Date W Del
Add Invoice ltem URL (formula) Del Invoice # Numeric (reference proxy) J| Del
Total Invoice Amount Currency (summary) Del Invoice - Client - Address: City Text (lookup) Del
# of Invoice ltems MNumeric (summary) Del Invoice - Client - Address: Postal Code  Text (lookup) Del
Invoice Item - Min RID# MNumeric (summary) Del Invoice - Client - Address: State/Region Text (lookup) Del
Q2Q - QuickBooks Invoice # MNumeric (summary) Del Invoice - Client - Address: Street 1 Text (lookup) Del

Invoice - Client - Address: Street 2 Text (lookup) Del
Invoice - Client Name Text (lookup) Del

Page 27 © Copyright 2024 VARC Solutions. All Rights Reserved.



Q2QConnect Manual VARC Solutions

Mapping Transactions

Let’s get your transactions mapped! Follow the general transaction mapping instructions on
Page 15, and make sure you read the section on structuring your Quickbase application and
which table to map BEFORE proceeding.

Then, refer to this section for specifics about mapping each transaction.

= Transaction Field Mapping
Purchase Order | hem Receipt | Bil | Bill Credit | CC Change | CC Credit | Timesheet
Numbering Estimate | Sales Order ! Invoice | Credit Memo Payment

In this section, we’ll cover mapping the following transactions:
e Customer Transactions:
e Estimate
e Sales Order
e Invoice and Invoice Paid Status
e Credit Memo
e Payment
e Vendor Transactions:
e Purchase Order
e Item Receipt
e Bill and Bill Paid Status

e Bill Credit
e CCCharge
e CC Credit

e Employee Transaction
e Timesheets

Remember: To start mapping transactions, open Q2QConnect, click Connect, then click Settings
> Maps — Transactions from the menu.

Refer to the individual transaction to see a complete list of fields you can map in Q2QConnect.
It’s also important to note here that Q2QConnect maps transactions only in one direction: from
Quickbase to QuickBooks. So, Quickbase will be the Master in terms of where transactions are
entered. And then those transactions will be transferred to QuickBooks using Q2QConnect.
Fields shown in Red font are written back to Quickbase.

PRO TIP: QuickBooks transactions sometimes have drop-down list fields, such as Customer
Message, Template, Terms, Rep, ship Via, etc. Q2QConnect allows you to map these fields to

Quickbase. However, the data coming in from Quickbase must match an available list option in
QuickBooks exactly. See page 64 for more information.
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In the example below, we have two tables in Quickbase; a parent table named Estimates and a
child table named Proposal Items. We’re mapping the Proposal Items table in Quickbase to

Estimates in QuickBooks.

Purchase Order | tem Receipt | Bil | Bil Credit | CC Charge | CC Credit | Timesheet |
Numbering | Estmate | SalesOrder | invoice | Credit Memo | Payment |
Direction of data transfer: QuickBase —> QuickBooks
[W] Allow updates to QuickBooks estimates faster if unchecked)
QuickBase Table V] Show details
QuickBase Field QuickBooks Field
Q2Q Date v | Date
Q2Q GB Full Customer Name v | Customer Name
Q20 Ref No w | Ref No (Line tem Grouping)
Quick Books Quate # v | Quote No
v | Template
Q2Q Bill To Line 1 v | Bill4o Address Linel
Q24 Bill To Line 2 v | Bill4o Address Line2
Q2Q Bill To Line 3 + | BilHo Address Line3
Q23 Bil To Line 4 v | Bil4o Address Lined
Q2Q Bill To City v | Bill+o City
Q24 Bill To State v | Bil4o State/Province
Q24 Bill To Zip v | Bill4o Zip/Postal Code
+ | Bil4o Country/Region
Q20 Ship To Line 1 v | Ship4o Address Line1
Q2Q Ship To Line 2 v | Ship4o Address Line2
Q2Q Ship To Line 3 v | Ship4o Address Line3
Q2Q Ship To Line 4 v | Ship4o Address Line4
Q2Q Ship To City v | Ship4o City
Q20 Ship To State v | Shipto State/Province
Q2Q Ship To Zip v | Ship4o Zip/Postal Code
v | Shipto Country/Region
Q2Q FOB v |FOB
Q2Q Due Date v | DueDate
Q2Q Memo + | Memo
Q20 CustomerMsg v | CustomerMsg
Q24 Terms v | Terms
Q20 Sales Rep Initials v | salesRep Intials
Q2Q To Be Emailed v | ToBeEmailed
Q2Q tem LineNo v | tem LineNo
Q20 QB tem v | ltem Name
Q2Q Description v | Description
Q2Q Site v | Site
Q2Q Gty v | Quantity
Q2Q Price v | Price
Q2Q Class v |Class
Q20 OK To Send v | OkToSend
Cancel || ApplyChanges ||  Save4Close

Page 29

QuickBooks Required Fields:
e Date
e Customer Name
e [tem Name

Fields That Are Written Back to
Quickbase:
e (Quote No

© Copyright 2024 VARC Solutions. All Rights Reserved.




Q2QConnect Manual VARC Solutions

Estimate Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Create Estimates (Editing Transaction_)

Main Formatting Send/Ship Reports Search oA
@ p s E % a Create a Copy e E = v/ Email Later m acwme Invoice M Create Purchase Order @
Find New Save Delele Memorize Mark As Print  Email Aftach Create Sales Order
= v » Inactive - - File = St
Estimate DAE  NAME/ADDRESS swie 7o Ship To 1 =
03142020 @ apercrombis LLC 123 SomeAvenue |
ESTIVATE & 1553 Sullivan Road Happy Town, Texas 123.
gton, Virginia 22217 USA
|A-900000 | Tichng
P.O. NO. TERMS DUE DATE REP FoB SPOUSE'S NAME BIRTHDAY WES URL OTHER
I - 0122020 @ |JDD ~ PP &Add ]
ITEM | DESCRIPTION ISITE DETY E68T AmouNT | MARKUP | CLASS i MPN OTHER1 : OTHERZ : COLOR ! MATERIAL | TOTAL | TAX
Deck Lumber Soil Tk 215| 2,601.50 0.00 Overhead 12 2,601... Tax <
Flowers - Perrenial Deck Lumber - posts 30 380 114.00 0.00 ‘MEGU | 10 114.00 Tax
and supports ‘
Lighting Lighting 12 150.00 | 1,800.00 0.00 Overhead 75 1,800... | Tax
Concrete Slab Rocks | 15 70,00 1,050.00 0.00 ‘(Nwhoad | 13 1,050... Non
¥
m susToTaL  USD 5.565.50
waRkUP  USD 0.00
X |County,San__. ~ | (6.5%) USD 293 51
GUSTOMER MESSAGE o USD 5,859.01
Please review this quote, — _ l
we look forward to working...
o [Landscapingproeet | cosoes | save & close Rovert
——————

PRO TIP: You don’t need to map the line Total or Extended price. QuickBooks automatically
calculates the total based on the Qty * Rate.
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Sales Orders

In the example below, we have two tables in Quickbase; a parent table named Sales Orders and a
child table named Invoice Items. We’re mapping the Invoice Items table in Quickbase to Sales Orders
in QuickBooks.

QuickBooks Required Fields:
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Purchase Order | tem Receipt | Bil | Bill Credit | CC Charge | CC Credit | Timesheet | e Date
Numbeing | Estmate | SalesOrder |Inwoice | Credit Memo | Payment |
e Customer Name
Direction of data transfer: QuickBase —> QuickBooks ° |tem Name
[w] Allow updates to QuickBooks sales orders faster f unchecked)
Qckfose Toble [voen b Y] [ Sowdsak Fields That Are Written Back to
QuickBase Field QuickBooks Field .
920 Dae “Tos Quickbase:
Q2Q QB Full Customer Name v | Customer Name e S.O0.No
Q2Q Ref v | Ref Mo (Line ttem Grouping)
QuickBooks SO # v|50. No
Q2Q Template (Sales Order) v | Template
Q2Q Bill to Address Line 1 v | Bill+o Address Line1
Q2Q Bill to Address Line 2 + | Bill4o Address Line2
Q2Q Bill to Address Line 3 v | Bil4o Address Line3
Q2Q Bill to Address Line 4 + | Bill4o Address Lined
Q2Q Bill to City w | Bill4o City
Q2Q Bill to State/Province v | Bil4o State/Province
Q2Q Bill to Zp/Postal Code + | Bill4o Zip/Postal Code
+ | Bill4o Courtry/Region
Q24 Ship to Address Line 1 + | Shipto Address Line1
Q2Q Ship to Address Line 2 + | Shipto Address Line2
Q2Q Ship to Address Line 3 v | Ship4o Address Line3
Q20 Ship to Address Line 4 w | Shipto Address Lined
Q2Q Ship to City + | Shipto City
Q2Q Ship to State/Province + | Ship4o State/Province
Q24 Ship to Zip/Postal Code w | Shipto Zip/Postal Code
+ | Ship4o Country./Region
Q2Q PO No v |P.O. No
Q24 FOB v | FOB
Q24 Due Date v | DueDate
Q2Q Ship Via + | ShipVia
Q20 Ship Date v | ShipDate
Q2Q Memo w | Memo
Q2Q CustomerMsg w | CustomerMsg
Q2Q Terms v | Tems
Q2Q Exchange Rate w | Exchange Rate
Q20 Sales Rep Initials v | SalesRep Initials
Q24 To Be Printed w | ToBePrinted
Q2Q To Be Emailed + | ToBeEmailed
Q2Q em LineNo v | ftem LineMNo
Q2Q ttem Name v | tem Name
Q2Q Description + | Description
Q2Q Site v | Site
Q24 Gty w | Quantity
Q20 Price w | Price
Q2Q Class v | Class
Q2Q OK'to Send v | OkToSend
Cancel || ApplyChanges || SavedClise
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Sales Order Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Create Sales Orders (Editing Transaction...)

Main Formatting Reports Search 2 A
«» B H X Create aCopy €@ & @ ) PuniLater @  &ocreat mvoice
Find New Save Delete a Memorize Mark As Print  Email | | Email Later Aftach E Create Purchase Order
i, Closed i > File

DA NAME/ADDRESS SHIF TC .
Sales order |W| W 'Weeks Health Care

S.0. NO. 689 Paget Park 42 Rusk Park

|r| Atlanta, Georgia 30306 San Jose, California 951

P.O. NO. TERMS DUE DATE REP SHIF DATE SHIP V1A

654 |Due onreceipt ~ 0212412020 [ 4B ~ 02242020 @ UPS
CLASS L ITEM ! DESCRIFTION  : ORDERED i sITE i RATE § AMOUNT ! TAX It
Design Lumber  Con. 70 ' 899 62930 Tax | 0 “
Design Patio Door  Fountain 12 200.00 2,400.00 Tax

m ™ [County,S.. - (65%) USD 196.90
TOTAL UsD 3,226.20
CUSTOMER MESSAGE
‘NI work is complete! = ‘
MEMO |Custurn fountain b... | CUSTOMER TAX CODE - Save & Close Revert

PRO TIP: You can map the Customer Message field. However, if mapped, the Customer
Message text in Quickbase must match one of the drop-down list options in QuickBooks
exactly.
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In the example below, we have two tables in Quickbase; a parent table named Invoices and a child
table named Invoice ltems. We’re mapping the Invoice Items table in Quickbase to Invoices in
QuickBooks. For information about Invoice Paid Status, see Page 57.

Transaction Field Mapping

| Purchase Order | hem Receipt | Bil

| Mumbering

I Estimate

Direction of data transfer:

| Bl

| sales Order | Invoice

Credtt | CC Charge | CC Credit | Timeshest |
Credit Memo Payment

QuickBase —> QuickBooks

Allow updates to QuickBooks invoices faster if unchecked)

Show details

QuickBase Field

QuickBooks Field

Q20 Date

Date

(320 QB Full Customer Name

Customer Name

Q20 Ref

Ref Mo (Line kem Grouping)

QuickBooks Invoice #

Invoice Number

Q20 Template

Template

(320 Bill to Address Line 1

Bil4to Address Line1

(320 Bill to Address Line 2

Bill4o Address Line2

(2Q Bill to Address Line 3

Bill4o Address Line3

(320 Bill to Address Line 4

Bill4o Address Line4

Q20 Bill to City

Bill+o City

QuickBooks Required Fields:
e Date
e Customer Name
e [tem Name

Fields That Are Written Back to
Quickbase:

e Invoice Number

e Paid Status

e Date Paid

e Amount Paid

(2Q Bill to State/Province

Bill4o State/Province

Q2Q Bill to Zip/Postal Code

<

Bill4o Zip/Postal Code

<

Bill4to Country/Region

Q20 Ship to Address Line 1

Ship4o Address Line1

(20 Ship to Address Line 2

<

Ship4o Address Line2

(20 Ship to Address Line 3

<

Shipto Address Line3

(20 Ship to Address Line 4

<

Ship4o Address Lined

Q20 Ship to City v | Shipto City

(20 Ship to State/Province v | Shipto State/Province

Q20 Ship to Zip/Postal Code v | Shipto Zip./Postal Code
v | Shipto Courtry/Region

(320 PO No v|P.O. No

G20 FOB v |FOB

Q20 Ship Via v | ShipVia

(20 Ship Date v | ShipDate

Q20 tem Name v | Memo

Q20 CustomerMsg w | CustomerMsg

(G20 Tems v | Terms

(20 Exchange Rate v | Exchange Rate

(20 Sales Rep Initizls v | SalesRep Initials

Q2Q To Be Printed v | ToBePrinted

(120 To Be Emailed v | ToBeEmailed

(20 Paid Status v | Paid Status

(32Q Date Paid v | Date Paid

(Q2Q Amount Paid v | Amount Paid

Q20 A/R Account v | A/R Account

Q20 tem LineNo v | tem LineNo

Q20 ttem Name v | tem Name

Q20 Description v | Description

Q23 Site v | Site

Q20 Gty v | Quantity

(2Q Price v | Price

(23 Service Date v | Service Date

(20 Class v | Class

Q20 OKto Send v | OkToSend

Cancel | | Apply Changes | | Save & Close |
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Invoice Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Create Invoices (Editing Transaction...)

Main  Formatting  Send/Ship  Reports  Search 2 oA
P Y ’ E 28 Bcreseacoay @ 8 (=)  Print Later m [ Add TimeiCosts =} Create a Batch
Find New Save Delele @BMemorize MarkAs ~ Print  Email [ | Emalllaler =~ Atach B Apply Credits Receive B Refund/Credit
% % Pending x o File Payments

CLASS _ L= New Productin...

I = DATE BILLTO SHIP TO ™
nV0|Ce' See History 04/01/2020 @& DJ's Computers
INVOICE # 11'01 Ba?séiglgm s
eague City, Texas
11159 =
P.O. NUMBER TERMS REF SHIP VIA F.O.B.
03-16-2020 Net 60 - - 04/01/2020 B -
SERVICED : ITEM CODE : DESCRIPTION ! QUANTITY a | PRICEEACH | CLASS { AMOUNT TA
Fountain Fountain 78 45.00 3,510.00 Tax ~
v
6 Your customer can't pay this inveice onliine T4 [Out of State 0.00
Turn on 3,510.00
CUSTOMER MESSAGE 0.00
3,5610.00

MEMO

: s ose

PRO TIP: You can map the Customer Message field. However, if mapped, the Customer
Message text in Quickbase must match one of the drop-down list options in QuickBooks
exactly.
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Credit Memos

In the example below, we have two tables in Quickbase; a parent table named Credit Memos and a
child table named Credit Memo Items. We’re mapping the Credit Memo Items table in Quickbase

to Credit Memos in QuickBooks.

VARC Solutions

| Purchase Order | tem Receipt | Bl
| Numbering | Estimate

| Sales Order | Invoice

Direction of data transfer: QuickBase —> QuickBooks

[] Allow updates to Quick Books credit memos faster f unchecked)

| Bill Credit | CC Charg

e [ CC Credit | Timesheet |

|CrediMernc

QuickBooks Required Fields:
e Date
e Customer Name
e [tem Name

Fields That Are Written Back to
Quickbase:

e Credit Memo Number

e Paid Status

e Date Paid

e Amount Paid

QuickBase Table ¥ Show cetails
QuickBase Field Quick Books Field
Q2Q Date v | Date
Q20 GB Full Customer Name + | Customer Name
Q20 Ref No | Ref Na (Line tem Grouping)
(Q2Q Credit Memo # v | Credit Memo Number
Q2Q Template w | Template
Q2Q Bill To Line 1 ~ | Bill4o Address Line1
324 Bill To Line 2 + | Bil4o Address Line2
Q2Q Bill To Line 3 « | Bill4o Address Line3
Q24 Bill To Line 4 v | Bil4o Address Lined
Q24 Bill To City w | Bill4o City
Q2Q Bill To State v | Bil4o State/Province
Q2Q Bill To Zp | Bilto Zp/Postal Code
w | Bill4o Country/Region
2Q Ship To Line 1 v | Shipto Address Line
020 Ship To Line 2 v | Shipto Address Line2
Q24 Ship To Line 3 v | Ship4o Address Line3
32Q Ship To Line 4 ~ | Shipto Address Line4
(Q2Q Ship To City v | Ship4o City
Q24 Ship To State w | Shipto State/Province
Q2Q Ship To Zip v | Ship4o Zip/Postal Code
w | Shipto Country/Region
Q20 PO # v |PO.No
Q20 FOB v |FOB
Q20 Ship Via w | Ship\ia
(320 Ship Date w | ShipDate
Q2Q Memo ~ | Memo
Q20 CustomerMsg w | CustomerMsg
Q2Q Terms w | Terms:
(320 Exchange Rate w | Exchange Rate
Q2Q Sales Rep Initials v | SalesRep Initials
G20 To Be Printed w | ToBePrinted
Q204 To Be Emailed + | ToBeEmailed
(020 Paid Status w | Paid Status
Q2Q Date Paid v | Date Paid
Q2Q Amount Paid ~ | Amount Paid
Q20 A/R Account v | A/R Account
Q2Q kem LineMNo + | tem LineMNo
(120 QB ftem v | tem Name
Q2Q Description w | Description
Q20 Site v | Site
Q20 Qty v | Quantity
Q20 Price ~ | Price
(Q2Q Service Date v | Service Date
Q20 Class v | Class
Q20 OKto Send v | OkToSend
Cancel | [ ApplyChanges | [  Saved Cose
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Credit Memo Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Create Credit Memos/Refunds (Editing Transaction...)

Main Formatting Reports oA
* ! E % & Create a Copy ° 8 (=7 | PrintLater m g Use credit to give refund

Find New Save Delele OMemmize Mark As Print  Email ||| Email Later Attach @Use credit to apply 1o invoice
= e Pending X 47 File

S8l Bayshore Gallery ~ cu.ss- TEMPLATE

Credit Memo ) e

CREDIT NO. 675 Queens Ave
Anchorage, Alaska 99053
1147
P.O. NO TERMS REF SHIF DATE SHIF VIA FOB
- ~ 04/05/2020 @ b
SERVICED ITEM DESCRIPTION QTY i RATE i CLASS A LI
04/05/2020 Gardening Gardening 5 20,00 100.00 MNon A
v
A Qut of State + | (0.0%) 0.00
TOTAL 100.00

CUSTOMER MESSAGE

:" 100.00

> Save & Close Revert

uEno | stuff

PRO TIP: You can map the Customer Message field. However, if mapped, the Customer
Message text in Quickbase must match one of the drop-down list options in QuickBooks

exactly.
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Payments (From Customers)

In the example below, we have a single table in Quickbase named Payments mapping to Payments
in QuickBooks. A child table isn’t necessary since payments do not include multiple line items.

[ A L] QuickBooks Required Fields:
Purchase Order | tem Receipt | Bil | Bil Credt [ CC Charge | CC Credit [ Timesheet | e Date
MNumbering I Estimate I Sales Order I Invoice I Credit Memo | Payment
e Customer Name
Direction of data transfer: GuickBase —> GuickBooks
[ Auto-apply payment f invoice is blank or not mapped
Fields That Are Written Back to
QuickBase Table Show details .
Quickbase:

QuickBase Field QuickBooks Field

Q20 Date v| Date e (none)

Q20 QB Ful Customer Name w | Customer Name

Q2Q Check # | Check No (Ref #)

Q2Q Method | Method

Q20 Memao v | Memo

Q2Q Deposit To « | Deposit To

Q24 Invoice # + | Invoice Number

Q20 Amount w | Amount

Q20 OKto Send w | OkToSend

Cancel | | Apply Changes | | Save & Close

Payment Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Receive Payments

Main Reports Payments 2 oaA
¢ B X Ea&a=2 ¢ & x B =
Find New Delete Print  Email Alach Look up Un-Apply Discounts And Record N r
x % File Customer/invoice Paymenl Credits Bounced Check Adk

Customer Payment

RECEVED FROM | Abercrombie LLC

8BS = e

PAYMENT AMOUNT 400.00

CREDIT
— CASH CHECK e &CHECK
DATE | 03/05/2020 =] v
CHECK# 150645693178 DEFOSITTO  Undeposited.. =
J i DATE _ NUMBER P C DUE PAYMEN
~ 01/23/2020 1109 6,750.00 400.00 400,00 &
03/08/2020 11153 20.00 20.00 0.00'
03/11/2020 11151 1,005.00 1,005.00 0.00
v
Totals 12,175.00 5,825.00 400,00
UNUSED CREDITS AMOUNTS FOR SELECTED INVOICES
FOR THI PHCERILLE 400.00
775.15
400.00
Apply Credits Tl
0.00
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Purchase Orders

In the example below, we have two tables in Quickbase; a parent table named Purchase Orders and
a child table named PO Items. We’re mapping the PO Items table in Quickbase to Purchase Orders
in QuickBooks.

QuickBooks Required Fields:
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[ Numbering | Estimate | Sales Order | Invoice | Credit Memo | Payment | e Date
Purchase Order | tem Receipt | Bl | Bil Credit | CC Charge | CC Credit | Timesheet |
e Vendor Name
Direction of data transfer: QuickBase —3> QuickBooks ° |tem Name
[w] Allow updates to Quick Books purchase orders faster f unchecked)
QuickBise Toble [P0 fome Y] Show daske Fields That Are Written Back to
QuickBase Field QuickBooks Field .
220 Date . Quickbase:
Q2 Vendor Name v | Vendor Name ° (none)
Q2Q Ref # + | Ref No (Line ltem Grouping)
QuickBooks PO # v |P.O. No
Q2Q Template w | Template
Q2Q Vendor Address Line 1 ~ | Vendor Address Line1
Q2Q Vendor Address Line 2 w | Vendor Address Line2
Q2Q Vendor Address Line 3 w | Vendor Address Lined
« | Vendor Address Lined
(Q2Q Vendor Address City « | Vendor City
Q24 Vendor Address State v | Vendor State/Province
Q2Q Vendor Address Zip ~ | Vendor Zip/Postal Code
@2Q Vendor Address Country v | Vendor Country/Redgion
Q2Q Ship To Line 1 | Shipto Address Line1
Q2Q Ship To Line 2 + | Shipto Address Line2
Q2Q Ship To Line 3 | Shipto Address Line3
+ | Shipto Address Lined
Q2Q Ship To City ~ | Shipto City
Q2Q Ship To State + | Shipto State/Province
Q2Q Ship To Zip | Shipto Zip/Postal Code
Q2Q Ship To Country + | Shipto Country/Region
Q2Q FOB ~ | FOB
Q2Q Ship Via + | ShipVia
Q2Q Due Date + | Due Date
Q2Q Memo w | Memo
Q2Q Tems w | Tems
Q20 Exchange Rate + | Exchange Rate
Q2Q To Be Printed + | ToBePrinted
Q2Q To Be Emailed v | ToBeEmailed
Q2Q tem LineNo + | tem LineNo
Q2Q QB tem « | kem Name
G2Q Description | Description
Q2Q Gty « | Quantity
Q2Q Cost w | Cost
Q2Q QB Full Customer Name w | Customer:Job
Q2Q Class w | Class
0Q2Q OKto Send (Purchase Order) OkToSend
| |[  SsavedClose
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Purchase Order Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Create Purchase Orders (Editing Transaction...)

Main  Formatting  Reports  Search oA
€ P ’ E % Create a Copy o B (=7 | |PrntLater m & @ Select llems Receipt EI
Find New Save Delete OMemorize Mark As Print  Email ' Email Laler Attach Create liem View *
x Closed % i File Receipls Vendor P
Purchase Order R = -
' Organic Distributors, Ir ~ Q2Q - Larry's Landscag
P.O. NO, Organic Distributors, Ir 906 Anna Lane
(5207 /5701 N. Baseline Rd Friendswood, TX 7754¢
Tucson, Arizona 85751
‘United States.
TERMS DUE DATE SHIF VIA FOB
Net 30 - 03/13/2020 E4 -
RECEIVED STATUS | ITEM DESCRIPTION | QTY cosT i CUSTOMER F CLASS | AMOUNT RCV'D CLSD
Open Deck Lumber DecklLumber 2 185.00 Abercrombie LLC 37000 0 A
Open Soil Hard soil 400 10.00 Abercrombie LLC 4,000.00 0
v
e RS 4,370.00
wewo | Soil for cleared path Save & Close Revert
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Iltem Receipts

In the example below, we have two tables in Quickbase; a parent table named Item Receipts and a
child table named Bill ltems. We’re mapping the Bill Items table in Quickbase to Item Receipts in
QuickBooks.

Transaction Field Mapping =] QuickBooks Required Fields:
Mumbering I Estimate | Sales Order I Invoice I Credit Mema I Payment | o Date
Purchase Order | tem Receipt | Bl | Bil Credit | CC Charge | CC Credit | Timeshest |
e Vendor Name
Direction of data transfer: QuickBase —> QuickBooks
e |tem Name
Allow updates to QuickBooks item receipts faster if unchecked)
QuickBase Table Show details . .
Fields That Are Written Back to
QuickBase Field QuickBooks Field
Q20 Date <Joate Quickbase:
Q2Q Vendor Name v | Vendor Name o Bi I I a b I e
Q20 Ref # ' | Ref Number
Q20 A/P Accourt v | A/P Accourt
Q20 Memo v | Header Memo
(120G QB tem v | ftem Name
(20 Description v | Description/Memao
Q20 Gty v | Quantity
G203 Cost v |Cost
(412G Customer Job v | Customer:Job
Q20 Site v | Site
Q20 Class v |Class
Q20 Billable v | Billable:
Q20 Expense Account v | Expense Account
Q20 Expense Amournt v | Expense Amourt
Q20 - tem Receipt - OKto Send v | Ok ToSend
Cancel | | Apply Changes | | Save & Close
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Item Receipts Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Items Tab

Create ltem Receipts

Main Reports Search

«» B B X Qoowecr 3 0 B O B

Find New Save Delete QMemori:e Print Attach Select Enter Clear Recalculate
l ! File PO Time Splits

Bill Received

ltem Receipt

VENDOR  (\Wilson's Works = DATE 03/05/2020 B
REF. NO. 8675
TOTAL 35.00

MEMO Received items (bill to follow)
Expenses $0.00 Items £35.00

TEM DESCRIPTION : QTY COST AMOUNT CUSTOMER:JOB BIL... ! CLASS

Trimming  Trimming 1 35.00 35.00 |Suzie’s Cupcake v s

Save & Close Revert

Expenses Tab

Expenses $0.00 Iitems $35.00

ACCOUNT AMOUNT MEMO + CUSTOMER:JOB BILLA CLASS

Save & Close . Save & New . Revert
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Bills and Bill Paid Status

In the example below, we have two tables in Quickbase; a parent table named Bills and a child
table named Bill ltems. We’re mapping the Bill Items table in Quickbase to Bills in QuickBooks. For
information about Bill Paid Status, see Page 58.

= Transaction Field Mappi <] : : ;
= S QuickBooks Required Fields:
[Numbeing | Estimate | Sales Order | Invoice | Credit Memo | Payment | e Date
| Purchase Order | tem Receipt | Bil | Bill Credit | CC Charge | CC Credt | Timesheet |
e Vendor Name
Direction of data transfer: QuickBase —> QuickBooks
_ _ _ e Ref Number
[w] Allow updates to QuickBooks bills faster f unchecked)
[ ]
QuickBase Table [w] Show details Item Name or Expense
QuickBase Field QuickBooks Field ACCO unt
Q2Q Date v | Date
823 Vendor Name ~ { Vendor Name Fields That Are Written Back to
Q20 Ref # (Bill) | Ref Number .
Q20 AP Account v | AP Account Quickbase:
Q20 Header Memo w | Header Memo Y Paid Status
Q2Q Terms w | Terms .
Q20 Exchange Rate w | Exchange Rate b Date Pa Id
Q20 Paid Status v | Paid Status e Amount Paid
Q2Q Date Paid v | Date Paid ° Blllahlp
Q2Q Amount Paid v | Amount Paid
Q2Q QB ttem v | tem Name
Q20 Description + | Description,/Memo
Q20 Gty v | Quantity
Q2Q Cost v | Cost
Q2Q QB Full Customer Name v | Customer:Job
Q2Q Ste v | Site
Q2Q Class v |Class
Q2Q Billable v | Billable
Q20 BExpense Account v | Expense Account
Q2Q Bxpense Amount v | Bxpense Amount
Q2Q OK to Send (Bill) v | OkTaoSend
[ cacel || oplyChanges || SavedCiose
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Bills Mappable Fields

VARC Solutions

The following highlighted QuickBooks fields are mappable to Quickbase:

Iltems Tab
= Enter Bills -0 %
Main Reports Search oA
*» B B X Qowecr 3 § B O m
Find New Save Delele QMemarize Print Aftach Select  Enter Clear Recalculate
v W File PO Time Splits
Cl:-T ) Credit | Bill Received
VENDOR | Ally's Oddities - DATE 02/01/2020
srrmeee | Allys Oddities o CR123
~ 610 W Bush St Apt 201 AUOUNT DUE
Middlefield, CA94482 : 132100
USA
BILL DUE 02M11/2020 £
TERMS Net 10 - DISCOUNT DATE CLASS -
VEMD
Expenses $0.00 Items $132.00
TEM DESCRIFTION QT cosT UN CUSTOMER:JOB BILLABLE? | CLASS
Citrus Trees | Orange Blossoms 2 66.00 132.00 ABC Pest of America = A
v
Save & Close Revert
Expenses Tab
Expenses $0.00 Iltems $132.00
ACCOUNT AMOUNT MEMT CUSTOMER.JOB t BILLA CLASS
I A
=
Save & Close §m &_New Revert
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Bill Credits

In the example below, we have two tables in Quickbase; a parent table named Bills (where we
enter Bills and Bill Credits) and a child table named Bill ltems. We’re mapping the Bill ltems table in
Quickbase to Bills Credits in QuickBooks.

Transaction Field Mappi [x] . . .
PRig QuickBooks Required Fields:
| Numbering I Estimate I Sales Order I Invoice I Credit Memo I Payment | ° Date
| Purchase Order | kem Receipt | Bil | Bil Credit | CC Charge | CC Credit | Timeshest |

e Vendor Name
e [tem Name or Expense

Direction of data transfer: QuickBase —> QuickBooks

[v] Allow updates to Quick Books bill credits faster if unchecked)

s e 9 o Account
QuickBase Field QuickBooks Field
Q20 Date v | Date Fields That Are Written Back to
Q2Q Vendor Name w | Vendor Name Quickbase,
Q20 Ref # (Bil Credt) v | Ref Number -
Q20 AP Account v | AP Account e Paid Status
Q2Q Header Memo v | Header Memo Y Date Paid
Q20 Exchange Rate + | Exchange Rate .
Q20 Credit Amount w | Credit Amourt hd Amount Pald
@2Q Open Amourt v | Open Amount e Billable
Q20 QB kem w | kem Name
Q20 Description w | Description/Memo . . .
™ v Note: When sending bill credits to
Q20 Cost v | Cost QuickBooks, the total of all line
zz Cs’: £ Costomer Name ’ ;“"'"“J"b items should be a positive number.
e e
20 G vy P The positive Bill Credit amount will
G20 Bable v | abie be a reduction of Accounts Payable
Q2Q Expense Account v | Expense Account . .
Q2Q Expense Amount (Credit) v | Expense Amount in QU ICkBOOkS'
Q20 OK To Send (Bil Credt) v | OkToSend

[ cancel | [ PepyChanges ||  Save&Ciose
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Bill Credit Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Items Tab
Enter Bills (Editing Transaction...)
Main  Reports  Search H oA
> B B X Qoween @ @ B O B
Find New Save Delele aMemoti:e Print Attach Clear Recalculate
g v File Splits

Bl @ Credit

Credit

VENDOR  Ally's Oddities i DATE 02/01/2020 @

REF. NO CR-123

CLASS v CREDITAMOUNT (13200
VEMD
Expenses $0.00 Items $132.00
TEM DESCRIPTION QTY | COST OUN CUSTOMER:JOB ! BILLABLE? | CLASS
Citrus Trees Orange Blossoms 2 66.00 132.00 ABC Pest of America 74 -
v
Expenses Tab
Expenses $0.00 Hems $132.00
ACCOUNT AMOUNT MEMO CUSTOMER:JOB BILLA.. } CLASS
A
v
Save & Close Save & New Revert
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In the example below, we have two tables in Quickbase; a parent table named Bills (where we
enter Bills that are subsequently paid with Credit Card) and a child table named Bill Items. We're
mapping the Bill Items table in Quickbase to Credit Card Charges in QuickBooks.

QuickBooks Required Fields:
e Date
e Payee Name
e |tem Name or Expense
Account

Fields That Are Written Back to
Quickbase:
e Billable

Transaction Field Mapping -
Numbering | Estimate | Sales Order | Invoice | Credit Memo | Payment |
Purchase Order | tem Receipt | Bil | Bill Credit | CC Charge |CC Credit | Timeshest |
Direction of data transfer: QuickBase —> GuickBooks
[ Allow updates to Quick Books CC charges faster f unchecked)
QuickBase Table |Bill tems W Show details
QuickBase Field QuickBooks Field
(G20 Date w | Date
Q20 Vendor Name w | Payee Name
Q20 Bill Ref # ~ | Ref Number
Q20 Expense Account w | Credit Card Account
Q20 Header Memo v | Header Memo
(32Q Exchange Rate + | Exchange Rate
Q20 tem + | tem Name
(20 Description w | Description/Memo
Q20 Gty w | Quantity
Q23 Cost | Cost
Q203 Full Customer Job + | Customer:ob
Q20 Site ~ | Site
(20 Class v | Class
Q23 - Bilable ~ | Billable
Q20 Expense Account + | Expense Account
Q20 Expense Amount w | Expense Amount
(32Q - CC Charge - OKto Send v | OkToSend
Cancel | | Apply Changes | | Save & Close

Pa
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Credit Card Charges Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Items Tab
Enter Credit Card Charges - Visa 0129 (Editing Transaction...)
Main Reporis A
o b = =

& P s E S@ Greate a Copy @ ? Download Card Charges ﬁ ©) @ E’I’

Find New Save Del-ete °Memmize Agach Select Ente : Clear Recalculate Py b
e PO Splits
Transaclic
CREDITCARD | Visa 0129 - @ Purchase/Charge () Refund/Credit  ENDING BALANCE 0.00

Credit Card Purchase/Charge

PURCHASED FROM | Ally's Oddities - DATE 0412312020 ]

REF NO. |CC5678
CLASS - AMOUNT  1100.00

MEMO Fﬁliéﬂe- marl'ce-rs fuf gal-'dén projecls -

Expenses $0.00 Items $100.00 Ready to pay a credit card bill?
ITEM - DESCRIPTION QTY [ COST | AMOUNT i CUSTOMER:JOB i BILLABLE? : CLASS
Foliage TagsMarkers In-ground signs describing foliage 2,000 0.05 100.00 -

Save & Close cloar

Expenses Tab

Expenses $0.00 [lems $100.00 Ready to pay a credit card bill?

ACCOUNT AMOUNT MEMO CUSTOMER:JCB BILLABLE? : CLASS

Save & Close Clear
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Credit Card Credits

In the example below, we have two tables in Quickbase; a parent table named Bills (where we
enter Bills, bill payments via Credit Card, and credit card credits) and a child table named Bill Items.
We’'re mapping the Bill ltems table in Quickbase to Credit Card Credits in QuickBooks.

Transaction Field Mapping B | QuickBooks Required Fields:
MNumbering I Esltimate I Salias Order I In\ioice ||Cred'rt Memo| | Paymert | [ ] Date
Purchase Order | tem Receipt Bill Bill Credit | CC Charge | CC Credit | Timesheet
e Payee Name
Direction of data transfer: QuickBase —> QuickBooks ° Item Na me or EXpense
[ Mllow updates to Quick Books CC credits faster f unchecked)
Account
QuickBase Table Show details
QuickBase Field QuickBooks Field . .
020 b “Toae Fields That Are Written Back to
Q2Q Vendor Name + | Payee Name Quickbase:
Q20 Bill Ref # v | Ref Number ° Bl”able
Q20 AP Accourt | Credit Card Account
Q20 Header Memo v | Header Memo
Q20 Exchange Rate v | Exchange Rate Note: When sending credit card
a2 fen | tem Name credits to QuickBooks, the total of
Q20 Description | Description/Memo . . .
G ~ | Quantiy all line items should be a positive
Q20 Cost v | Cost number. The positive Credit Card
Q23 QB Full Customer Name | Customer:Job Cl’edlt amount W|“ be a reductlon
Q20 Ste v | Site .
020 O [ of the related Credit Card account
Q20 - Bilable v | Bilable in QuickBooks.
Q20 BExpense Account w | Expense Account
Q20 Expense Amount {Credit) + | Expense Amount
Q23 - CC Credit - OKto Send v | OkToSend
| Cancel | | Apply Changes | | Save & Close
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Credit Card Credits Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Items Tab

Enter Credit Card Charges - Visa 0129 (Editing Transaction...)

Main Reporis

& D Q E 23 Create a Copy @ @ Download Card Charges |/ '\'3 E E"”’ !

Find New Save Delete OMemorize Attach elect Eni Clear Recalculate
- Batch
File Splits
Transactic
creDITcArRD | Visa 0129 = | (O Purchase/Charge (@ Refund/Credit  ENDING BALANCE 0.00

Credit Card Refund/Credit

PURCHASED FROM | Ally's Oddities - DATE 04/23/2020 B
REFNO, |CCR158

ASS - AMOUNT 10.00

wewo  Foliage markers for garden projects

Expenses $0.00 Iltems $10.00 Ready to pay a credit card bill?
ITEM DESCRIPTION QTY COST AMOUNT CUSTOMER:JOB : BILLABLE? : CLASS
Foliage TagsMarkers In-ground signs describing foliage 200 0.05 10.00 A
v
R Show
Expenses Tab
Expenses $0.00 ltems $10.00 Ready to pay a credit card bill?
ACCOUNT AMOUNT MEMQ i CUSTOMER:JOB i BILLABLE? ! CLASS
A
Y

Page 49 © Copyright 2024 VARC Solutions. All Rights Reserved.



Q2QConnect Manual VARC Solutions

Timesheets

In the example below, we have a single table in Quickbase named Timesheets mapping to
Timesheets in QuickBooks. A child table isn’t necessary since timesheets do not include multiple
line items.

Transaction Field Mapping [x] QuickBooks Required Fields:
Numbering I Estimate | Sales Order | Invoice | Credit Memo | Payment | [ Date
Purchase Order | kem Receipt | Bil | Bil Credit | CC Charge | CC Credit | Timeshest |_ Employee Name
* Y
Direction of data transfer: QuickBase —> CuickBooks ° Payrol I |tem
Allow updates to Quick Books timesheets faster if unchecked) f . | f
[] Update GuickBase billable status from QuickBooks (I payl ng em p Oyees or
QuickBase Table Show detais time)
QuickBase Field QuickBooks Field ° CUStomer:JOb and SerV|Ce
Q20 Date v] Date Item (if time entry marked
Q20 Employee Name w | Employee Name as b|”a ble)
Q20 QB Full Customer Name | Customer:Job
Q20 Service ltem w | Service ftem
Q20 Payrol ftem v | Payrol tem Fields That Are Written Back to
(324 Duration ~ | Duration Quickbase:
Q2q Billable + | Billable
Q20 Notes « | Notes o (none)
Q20 Class v |Class
Q20 OKto Send w | OkToSend
Cancel | | Apply Changes | | Save & Close

Timesheet Mappable Fields
The following highlighted QuickBooks fields are mappable to Quickbase:

Time/Enter Single Activity

@ Previous ® Net | [ Spelling [E] Timesheet

DATE 03/M16/2020 @ PAYROLL ITEM Regular Pay > NOT BILLED
NAME Alexandra Hall - + Billable
CUSTOMER-JOE Bayshore Chamber of Commerce b CLASS -
SERVICE ITEM Pest Control -
DURATION

NOTES  Spraying for fireants and grub

© 5:00 o

Start

Save & Close Revert
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PRO TIP: To import time into QuickBooks, you must check the “Use Time Data to Create
Paychecks” box on the Edit Employee, Payroll Info tab.

= Edit Employee - 0 X
wromuemion For Alexandra Hall
Personal e S A
R CHEDULE - @ Direct Deposit Taxes...
Address & Contact PAY FREQUENCY  Biweekly -

Sick/Viacation...

Additional Info

Payroll Info
EARNING 5 ADDITION S, DEDUCTIONS AND COMPANY CONTRIBUTIONS

Employment Info

Regular Pay 18.00 | &

¥ Use time data to create paychecks Employee is covered by a qualified pension plan

Employee is inactive “ Cancel Help
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Transaction Numbering
With Q2QConnect, you can select how customer transactions are numbered when transferred
to QuickBooks.

To specify transaction numbering, open Q2QConnect, click Connect, then click Settings > Maps
— Transactions from the menu. Then, click the Numbering tab.

You can select from two options for each transaction type:

e Use Quickbase transaction number
e Specify a Starting QuickBooks #

If you select Use Quickbase, Q2QConnect will apply the transaction number found in Quickbase
to the transactions being transferred to QuickBooks.

If you select Starting QuickBooks #, specify the next available number, a starting number of
your choosing, or a pattern such as S1000, EST101, 15000, or PO333. Q2QConnect will
automatically increment and update the number after each transfer.

You can enter a transaction text-number pattern, such as ABC-5000, using a dash "-" separator.
However, the dash must be proceeded by text and followed by a number. Text following the
dash or other special characters will not work.

Transaction Field Mapping -
Purchase Order | ltem Receipt | Bil | Bil Credit | CC Charge | CC Credt | Timeshest
Numbering Estimate | Sales Order | Invoice | Credit Memo | Payment

You can select how the transactions below are numbered. The
numbering can either be generated from QuickBase oryou can
enterin the next number for Quick Books to start the numbering.

Estimate

O Use QuickBase (® Starting QuickBooks #

Sales Order
O Use QuickBase

) Staring QuickBooks # |B-194

Invoice/Credit Memo

) Use QuickBase ) Starting QuickBooks # |C-200

Purchase Order

O Use QuickBase

) Starting QuickBooks # |A13

. a red label in the QuickBooks

ata is updated from Books to Base

Cancel | | Apply Changes | | Save & Close
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Initial List Load (Optional)

Once you’ve setup Q2QConnect and mapped your desired lists, you may want to load your
Quickbase list tables with existing list entries from QuickBooks. There are three reasons you
may want to do this:

1. You have empty list tables in Quickbase and want to populate them with the list entries
from QuickBooks

2. You want to purge the Quickbase list table entries and replace them with the list entries
from QuickBooks. This is helpful if your Quickbase application has test data you want to
clear out.

3. You want to append to the Quickbase lists with list entries from QuickBooks

If you want to start with an empty Quickbase table, check the box next to Clear all Quickbase
tables first. For a Customer Load, this means the mapped Customer table(s) in Quickbase will
be cleared prior to the transfer. CAREFUL! There is no Undo button!

You can also instruct Q2QConnect to set a TRUE flag for the OkToSend field in Quickbase. This
means that in future syncs, Q2QConnect will see those list entries IF you have mapped the list’s
OkToSend field to an OkToSend field in the Quickbase table.

Pro Tip: In our Best Practices section of this manual, we suggest creating Q2Q Formula Fields in
Quickbase to use for list and transaction mapping. However, Q2QConnect can’t update the
contents of Quickbase formula fields. To use this Load feature, your lists need to be mapped to
writable (non-formula) fields.

Show Initial Load Menu
1. Select Settings > Database Connections from the menu.
2. Click the box next to Show “Initial Load” menu.
3. Click Close. This setting will revert to unchecked after closing Q2QConnect.
€] Connection Settings [= o]

O Singleuser @ Muttiuser  Config Fle Path |3:\Q2Q Data Files\00 Q20 Config File'\Q20settin l:l

Q) Location  vancsolutions.quickbase.com

Email Address or Screen Name  |vanc_annette
QUICK |

BASE Password
Application Token |dg3ww3dJawggsci5budvhdgwk268
(QuickBase Database Name |Q20Q - Testing App 2020
QuickBase Database D |bnpdmma & | | Test Connection |

QuickBooks

Q:\Q2Q Data Files\Q2Q Testing QBW

Quick Books Company File Path
GuickBooks Comparry Name |Larry's Landscaping & Garden Supply | ‘ Test Connection

Connection Type Cpen Mode

Show “Initial Load” menu Save Settings | | Close
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Load Lists

1.

ouhkwnN

Page 54

Click Connect.
Select Initial Load > <List Name> Load from menu.

Wait for Q2QConnect to evaluate your list information.

Make appropriate selections in the Load window.
Click Load.
Repeat steps 1-5 for each list you wish to load.

There are 42 customers/jobs in your Quick Books comparny
'Q2Q - Lany’s Landscaping”
(read in 9.4 seconds)

Press ‘Load'to copy all your QuickBooks customers
into the Clients'table
in your Quick Base app ‘Lamy’s Landscaping’

There are cumently 42 customers in your QuickBase Clients' table

["] Clear all QuickBase tables first

[_] Load True'into QuickBase Ok ToSend field
[ Conesl ||

(%] Customer Load IL]E-

VARC Solutions
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Using Q2QConnect

Once you've setup Q2QConnect and mapped your desired lists and transactions, you are ready
to start using Q2QConnect! Congratulations!

Start by telling Q2QConnect which list and transaction buttons you want to see on the
Q2QConnect dashboard.

Choose Lists/Transactions for Button Bar
1. Select Settings > Choose Lists/Transactions from the menu.

Settings | Help

Database Connections

{ Choose Lists/Transactions

Maps - Lists

Maps - Transactions
Filters - Lists

Filters - Transactions

[] Customers [+] Estimates [ Purchase Orders [] Timeshests
[#] Vendors [w] Sales Orders [} Receipts
[+ tems [ Invoices [+ Bils
[ Employees [[] Invoice Paid Status [ ] Bill Paid Status
[ Credit Memos ] Bill Credits
[+ Payments [] Credit Card Charges

[[] Credit Card Credits

3. Click Save.

File Seftings Help

El o £ & [6] =]
ltems | Employees | Estimates | Sales Orders | Invoices | CreditMemos | Payments | Purchase Orders | Receipts | Bills  Timesheets fiSend Selected

onne:
view [ || CustomerSearch | From  [2/1172020 |70 [2r1er2020 | select All | Unselect A1l |

Base: 020 - Testing App 2020 Books: Larry's Landscaping Garden Supply

Page 55 © Copyright 2024 VARC Solutions. All Rights Reserved.



Q2QConnect Manual VARC Solutions

Filters
Before syncing, review and update the list and transaction filter settings. You can
include/exclude inactive records as well as specify the starting date or number of months of

transactions to include. This ensures you are bringing in appropriate records, and can speed up
the evaluation and transfer of data.

List Filters
1. Click Connect.
2. Select Settings > Filters — Lists from the menu.
3. Uncheck the box next to desired lists to exclude inactive records from being read. If the
box is checked, inactive records will be read.
4. Click Save & Close.
=) List Filters [ =]

Lse these settings to reduce the amount of data read from QuickBooks and Quick Base

Read Inactive records for
Customers/Jobs
Vendors
ltems
[] Employees

Cancel | | Sawve & Close
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Transaction Filters

1. Click Connect.

2. Select Settings > Filters — Transactions from the menu.

3. Select either a starting Fixed Date or a Fixed No. or Months to be included for each
transaction.
If you select a Fixed No. of Months, Q2QConnect will include that number of months
prior to the current date. If you choose a Fixed Date, Q2QConnect will include all
transactions from the selected date to today’s date.

4. Click Save & Close.

© Transaction Filters X
Use these settings to reduce the amount of transactional data read from Cuick Base
Fixed Statt Date Fixed No. of Months Fixed Start Date Fixed No. of Months

Estimates @ K y ® 1 = Sales Orders O z @ 1 5

Invoices olE ® 1 & Invoice Paid Status ol ETE ® 1 F

Credt Memos (O ® 1 D Payments (O ® 1 %

Purchase Orders Ol 2 ® 1 2 tem Receipts O Z ® 1 &

Bis O1 @1 2 Bil Paid Status O @) &
BilCredts O |1 ®1 =

Credit Card Charges (O | 1 ® 1 2 Credit Card Credits (O ® 1 %
Timesheets (O | 1 ® 1 &

Corcel

Invoice Paid Status

The normal Invoice transaction in Q2QConnect transfers invoices from Quickbase to
QuickBooks. The Invoices transaction filter is helpful because it reduces the amount of historical
Quickbase data that Q2QConnect considers transferring. We normally set this to 1 Fixed No. of
Months.

You'll use the Invoice button in Q2QConnect for your daily transfer of new or changed invoices.
However, what if you just want to update Quickbase with the paid status of invoices from
QuickBooks? You might need to look at invoices dated farther back in the past (example: an
invoice created 4 months ago that was finally paid today!). Instead of having to keep changing
the Invoices transaction filter, just use the Invoice Paid Status button, and expand the number
of months it considers.

Set your Invoice Paid Status transaction filter to something like 4 months, and Q2QConnect will
review the last 4 months of invoices, and update Quickbase if the paid status on those invoices
has changed. Note: you must also map the Invoices Paid Status field in Q2QConnect with a Paid
Status field in Quickbase.
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Bill Paid Status

The normal Bills transaction in Q2QConnect transfers bills from Quickbase to QuickBooks. The
Bills transaction filter is helpful because it reduces the amount of historical Quickbase data that
Q2QConnect considers transferring. We normally set this to 1 Fixed No. of Months.

You’ll use the Bills button in Q2QConnect for your daily transfer of new or changed bills.
However, what if you just want to update Quickbase with the paid status of bills from
QuickBooks? You might need to look at bills dated farther back in the past (example: a bill
created 4 months ago that you paid today). Instead of having to keep changing the Bills
transaction filter, just use the Bill Paid Status button, and expand the number of months it
considers.

Set your Bill Paid Status transaction filter to something like 4 months, and Q2QConnect will
review the last 4 months of bills, and update Quickbase if the paid status on those bills has
changed. Note: you must also map the Bills Paid Status field in Q2QConnect with a Paid Status
field in Quickbase.
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Sync List or Transaction
In the example below, we are syncing Customers from Quickbase to QuickBooks. The same
steps apply regardless of which list or transaction you are transferring using Q2QConnect.

Sync

1. Click Connect.

2. Click on the desired list or transaction button.

3. Click Select All if you want all entries transferred or click the Flag for Bulk Send box next
to the entries you want to transfer.

4. If you have selected multiple entries, click Send Selected. Otherwise, click Send next to
the individual entries to transfer.

5. Click OK on the informational window after the transfer is complete.

Q2QConnect: Select Entries to Send

Q2QConnect (= Lo |
—_—
] B ; & =3 e © s % a
Items Employees = Estimates = Sales Orders | Invoices = Credit Memos = Payments | Purchase Orders | Receipts Bills Timesheetsl Send Selected |
Customer Search From | 3/26/200 B~ | |Te [& 22020 B~ ] Select Al Unselect Al
QuickBase Customer Status Flag for Bulk Send to Books  Base Company Base Customer Base Address Base Address Base Address Base Address Base City Base ~
™2 Hew @ [ Send |(&'F3 CM2 2911 Early Tum Webster Texas
cM4 New O |_Send _lcM4 M4 | 2911 Early Tum .. Webster Texas
ABC Distributors New & ABC Distributors ABC Distrbutors | 306 Anna Lane Frendswood Texas il
ABC Pest of America [New [m] F=%end | ABC Pest of Ame... | | ABC Pest of Ame... |11 Remon Ln Lakewood |Mew Jersey |
Abercrombie LLC New O Abercrombie LLC Abercrombie LLC | Abercrombie. Krs Friendswood Texas
Adam's Candy Shop [New 0 [ Send | Adam's Candy Sn.. | Adam's Candy Sh... | Adem Bradiey. 15... Fudge Caifomia
Aero Componet Support Inc | New O |__Send | Aero Componet S Aero Componet S .|
Any Company of Texas New [m] [__Send ] Any Company of .. Any Company of ...
AOK Landscaping New E AOK Landscaping AOK Landscaping | 1711 Houston Ave Houston Texas
Bayshore Chamber of Commerce [New 0 [ Send | Bayshore Chamb... Bayshore Chamb... | 322 University Av... Houston Texas
Bayshore Gallery New O Bayshore Gallery Bayshore Gallery | 675 Queens Ave Anchorage Haska
Bowden Imaging Systems [New [m] [ Send | Bowden imaging . | Bowden Imaging ... | Brenda Bowden 52698 Main & |
Charbes Angel's Plumbing New O Charlies Angel's Charlies Angel's
DJ's Computers [New O [ Send | DJs Computens |DUs Computers | Computer Servic... SeklskeCty  Lkah
Ecker Design New O Ecker Design Ecker Design 109 N. Bim Street Laupahoehoe Hawai
Energy Effieciencies [New [m] Energy Effiecienc... Energy Bffiscienc... | [ -
< | L = >
Base: Larry's Landscaping g: T Books: Q2Q - Larry's Landscaping
Confirmation Window
Q2QConnect [ ]

41 Customers:Jobs were selected for transfer.

41 new Customers:Jobs were added to QuickBooks.

0 error(s) were encountered.
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Best Practices
We’ve compiled the following suggestions and best practices to help you be successful using
Q2QConnect.

Q2Q Starter App
e [f you haven’t built out your Quickbase app yet, you might consider purchasing our
Q2QConnect Starter App. We've built an app with all the tables and fields you would
need to get started in minutes. Call us at 281-412-6914 for current pricing.

Field Mapping
e Instead of mapping normal fields in Quickbase, set up Formula fields (text, numeric, or
date) instead which reference your normal Quickbase fields. For example, instead of
mapping a Customer Name field in Quickbase, set up a formula-text field called “Q2Q —
Customer Name”. Edit the formula for that field to point to the normal Customer Name
field. Then, in Q2QConnect, select the Q2Q — Customer Name field when mapping.

This allows you to change the formula/contents of that field later without having to
change the mapping in Q2QConnect. This approach makes the connection and mapping
more flexible going forward.

Formula-Text Field

SF&Chenrs Settings ~ Fields > Q2Q- Customer Name

» Exit Settings
Properties Usage Comments Dependency Diagram
v Basics
Label Q2Q - Customer Name
Type Text Change Type

Unique Must be unique

Sample Data

~ [Formula - Text field options

Formula 1 [client

Map Formula-Text Field
= List Field Mapping [

Customer | Vendor | kem | Employee |

Direction of data transfer: QuickBase —> QuickBooks

Pick Number of Levels |1 v] [ Show detais

Quick Base Table
Cients |v|Level 1

Save Tables / Reset Field Names |

Clients ] ] ]

| QuickBase Field QuickBooks Field 2

ll!‘

Customer Type
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Ok To Send
e When mapping lists and transactions in Q2QConnect, scroll to the bottom of the field

list and you’ll see an OkToSend field. This allows you to control in Quickbase which list
entries or transactions Q2QConnect can see. You can create an OkToSend formula-
checkbox field in Quickbase, and then build a formula to restrict which transactions flow
through Q2QConnect. For example, you might have an approval process in Quickbase,
and if a manager’s initials aren’t found, the OkToSend box is not checked. Q2QConnect
won’t see the transaction until the manager has approved the entry. The possibilities of
this technique are endless. Call us for a consultation to explore how this could be used
to maximize your workflow.

Formula-Checkbox Field

I:s"ulnvoices Settings «

Fields » Q2Q-Okto Send

&
» Exit Settings
Properties Usage Comments Dependency Diagram
~ Basics
Label Q2Q - Ok to Send
Type Checkbox Change Type
Sample Data Show

~ Formula - Checkbox field options

Totals Show a "totals" row in reports

Formula &1 if'f"al‘age:';«:na roval="",False,True])

Mapping the OkToSend Field
= List Field Mapping =3

Customer | Viendor | hem | Employee |

Direction of data transfer: QuickBase —> QuickBooks

Pick Number of Levels |1 JJ ¥ Show detals
Quick Base Table
Clients [v|Level

Save Tables / Reset Field Names |

Coorts.
QuickBase Field Quick Books Field 2
Q20 - Account Number v | Account Number
Q2G - Terms v | Terms
v | Tax Code
v | Tax tem
v | Resale No
v | SalesRep Inttials
Q20 -OKto Send v |OkToSend =
en Balance v |Upen Balance
| v | IsActive -
| Cancel || PooyChanges || SavedClose |
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Table Levels

With Q2QConnect, you can map up to 5 customer levels and up to 5 item levels. This
matches the capabilities of QuickBooks. However, in practice, mapping more than 2
levels makes your Quickbase application and mapping increasingly complex. If you find
yourself mapping more than 2 table levels, you may want to evaluate whether your
Quickbase application is set up correctly. Contact us for a consultation if you need help
in this area.

= List Field Mapping x]

_Customer]‘u"endorj tem :Emnlcwae_

Direction of data transfer:  QuickBase (O <— ® QuickBooks

Sales ONLY
Mapped (below)
Pick Number of Levels \ [¥] Show detais
1
QuickBase Table |2
QB tems - v]Level 1
5 |

Pro Tip: Even though you may have multiple levels (Customers, jobs) in Quickbase, you
can choose to just send 1 level to QuickBooks.

Syncing Multiple Levels

If you have established multiple table levels for customers (such as Customers — Level 1
and Jobs or Projects — Level 2) or Items (Items — Level 1 and Sub-ltems — Level 2), make
sure and sync the PARENT (or highest level) 1°t. Then, sync the 2" highest level, etc. in
progression. When you sync the parent item first, you’ll ensure that when the next level
is synced, the related parent item will be there. If you don’t follow this approach, you
could end up adding orphaned level 2 entries that have to be manually edited later.

& Q2QConnect ~ o |
File Settings Utilities Help
b o) & | B8 : & & e o : ) :
Connect = Customers = Vendors Items Employees = Estimates | Sales Orders Invoices | Credit Memos Payments Purchase Orders = Receipts Bills Timesheets = Send Selected
View |l v| | NameSearch From [3132020 B~ |To [4/132020 @~ | Select All  Unselect All
QuickBooks kem Name Status Flag for Buk Send to Base Books Full Name i Books Sublevel | Books ltem Type Books Manuf. Pat  Books Books Sales Books Sale ~
u 1 | *
Design Unchanged O Design 1 ice Yes Design 70
Gardening Unchanged Ez Send Gardening 1 ervice Yes Gardening 35
Installation Unchanged O Installation 1 ice Yes Installation 45
Pest Control Unchanged O Pest Control 1 envice Yes Pest Control 110
Tree Removal Unchanged [} Tree Removal 1 ervice Yes Tree Removal 126
Trimming Unchanged El Send Trimming 1 ervice Yes Trmming 50 v
< m >

Base: Larry's Landscaping ewing: Ite Books: Q2Q - Larry's Landscaping

Syncing Lists and Related Transactions

If you are syncing Customers and related customer transactions such as invoices,
payments, etc. always sync the list first to ensure you have brought in new customers.
Otherwise, your transaction sync might fail due to a missing customer. This concept also
applies to vendors and vendor transactions where you would want to sync your vendor
list before syncing vendor transactions.
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Initial Quickbase Table Population from QuickBooks

e If you are starting out with a fully populated QuickBooks file and an empty Quickbase

application, make sure and use our Q2QConnect Load utility to populate your Quickbase
list tables with data from QuickBooks.

See Page 53 for instructions on loading initial tables.
]
File  Settings | Initial Load | Help

®, %] Customer Load [ 5]
Connect | Custon Vi Employees

endor Load

View Iltem Load Search
’7 Employee Load

Show the Details During Sync

e When mapping your lists and transactions, check the box next to Show details. When

syncing, Q2QConnect will show you more information about what is being synced which
can be very helpful.

Show Details Option
Transaction Field Mapping =3

Purchase Order | kem Receipt | il Bill Credit | CC Charge | CC Credit | Timeshest |
MNumbering | Estimate | Sales Order | Imvoice Credit Mema Payment

Direction of data transfer: QuickBase —> QuickBooks

[#] Alow updates to QuickBooks invoices faster f unchecked)

QuickBase Table (v Show details

| QuickBase Field QuickBooks Field ~

More Details During Sync

d Q2QConnect
File Settings Utilities Help
£ a & | ] : & = e o = e

- -

View |New ~ Customer Search From | 3/13/2020 El~ | Te | 4/13/2020 [E~ Select Al Unselect All

Connect = Customers = Vendors Items Employees = Estimates = Sales Orders | Invoices Credit Memos | Payments = Purchase Orders = Receipts Bills Timesheets = Send Selected

-
Date Status Flag for Bulk Send to Books  f|Customer Name Ref No (Line kem  Invoice Number Template Biltc Address Bill4o Address Bill4o Address
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Mapping Transaction Drop-Down List Fields

e QuickBooks transactions sometimes have drop-down list fields, such as Customer
Message, Template, Terms, Rep, ship Via, etc. Q2QConnect allows you to map these
fields to Quickbase. If you choose to map such fields, you’ll want to create a multiple
choice field in Quickbase and only include options that are an exact match of the data in
QuickBooks. Otherwise the synced transaction will not flow into QuickBooks.

Drop-Down List Fields in QuickBooks

(SIS (e iz Adam's Candy ... ~

RSN Intuit Produ... ~

I nVOice See History

4 Deck Lumber Deck Lumber
<Add New >

All work is complete!
Its been a pleasure working with you!
Please remit to above address.
Thank you for your business.

‘We appreciate your prompt payment.

DATE -
DATE R e
BILLTO SHIF TO

041322020 B aAdam's Candy Shop Adam's Candy Shop
INVOICE & Adam Bradley

1528 Kitty Bang Bang St.
11162 By Bang Bang

Fudge, California 94555

BALANCE DUE

250.00

x Save & Close

Revert

Multiple-Choice Field in Quickbase

E" Invoices Settings ~
o o

x Exit Settings

It's

Please remit to above address.
Thank you for your business.
We appreciate your prompt payi

4 » A!

® Sort this field alphabetically
Sort this field in the order shown above

Allow users to create new choices

Create Cholces

Enter choices for the Customer Message field.

Next >>>
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Mapping Field in Q2QConnect
= Transaction Field Mapping [x]]

Payment | Purchase Order | tem Receipt | Bil | Timesheet
| Numbering I Estimate I Sales Order | Invoice Credit Memo |
Direction of data transfer: QuickBase —3> QuickBooks

[1 Allow updates to Quick Books invoices faster if unchecked)
|

QuickBase Table |Invaice hems v| ¥ Show details
QuickBase Field QuickBooks Field i
+ | Shipto Country/Region
Q24 - PO Number v |P.O. No
~ | FOB
~ | ShipVia
w | ShipDate
~

FAQs
We've collected some of the most common Q2QConnect questions and answers below. If you

have a question not answered here, call us at 281-412-6914, or submit a question through our
website contact us form at https://varcsolutions.com/contact-us.

Lists

How do | handle Items that are double-sided (including both sales and purchase info)?
In QuickBooks, if an item needs to be double-sided (including both the sales/income and
purchase/expense sides), that option needs to be specified within QuickBooks.

How do I track the Preferred Vendor for an Item?

If you are transferring Iltems from QuickBooks to Quickbase, the Preferred Vendor will only
populate to a text-only field; it will not go into a Related Vendor field. If transferring Items from
Quickbase to QuickBooks, you can use the Related Vendor field to move the information to
QuickBooks.

For Address State fields, do | use the state name or abbreviation?

The Quickbase address field type spells out the state name “Texas” verses using the state
abbreviation “TX”. QuickBooks typically uses the 2-digit state abbreviation. Q2QConnect
translates from “Texas” to “TX” and puts the abbreviation in QuickBooks. If you have TX in the
Quickbase state field, Q2QConnect can’t do the translation. Q2QConnect will push all of the
data that you have but it will show that the address does not match and will show up for sync
again. The resolution is to use the State field from the Quickbase address field type, or create a
state field in Quickbase that lists states using the name instead of the abbreviation.

Page 65 © Copyright 2024 VARC Solutions. All Rights Reserved.


https://varcsolutions.com/contact-us

Q2QConnect Manual VARC Solutions

Transactions

How do | update the Quickbase Paid Status on Invoices and Credit Memos that have changed
status?

If you have an invoice or credit memo that has been marked paid, but something changes in
QuickBooks or Quickbase to make that transaction unpaid, you will need to sync the changes
from Quickbase (such as an increase in the invoice amount, reduction of a payment, or
correction of a payment to another customer). Then sync again to pick up the paid status
change.

How do | map transactions that include multiple line items?

In order to ensure that multi-line transactions (Bills, invoices, etc.) map correctly, Quickbase
needs to be set up with two tables; one for the header (parent) and one for the line item detail
(child). Q2QConnect mapping should use the child table. Make sure to edit your parent/child
table relationship and add lookup fields to the child table for the required header/parent fields,
such as transaction date, client name, address, ref #, etc.

How do | ensure Q2QConnect applies payments to invoices correctly?
You have two options in Q2QConnect:

Option 1: Auto Apply Payment is Checked

This means that Q2QConnect will apply payments to the oldest invoice first if the invoice
number is not specified. If there is an over-payment on a specified invoice, the amount will
apply to the next sequentially dated invoice. If there are no more invoices, then the
overage will be left on the account as a credit to be applied later.

Option 2: Auto Apply Payment is Not Checked

The system will apply payments to invoices specified and add an additional payment for
any overage amount that is put on account (each payment with an overage will create a
separate payment). For payments without invoices specified, a payment will be added to
the customer’s account as a credit to be applied later.
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Additional FAQs

Are there any field limits | should be aware of?

All of the settings and field-length restrictions in QuickBooks will be followed when transferring
information to QuickBooks using Q2QConnect. If the QuickBooks character limit is exceeded,
the name and/or transaction will not go into QuickBooks, but an error message/error log will
indicate the problem.

For fields potentially longer than the character limit, we recommend you set up a formula field
that truncates the field to the max character limit, then map this formula field to the matching
QuickBooks field in Q2QConnect. This formula field can be pulled through to child tables in
QuickBase via table relationship lookup fields, if you are using it on transactions.

Field Maximum Characters
Account Name 31
Account Numbers 7
Amount 20
Customer message (Invoices) 101
Customer, Vendor Names 41
Employee Name (first and last) 25
Item Name 31
ltem Part Number 31
Item Description (Invoices) 4095
Job Description 99
Memo (Transaction) 4095
Notes in Shipping/Billing Address 41
Ship to Name 41
Invoice Number Field 11

What should the path be to my QuickBooks company file?

If your QuickBooks company file is stored on a server, then you’re able to get to the file through
a mapped drive or through a direct connect through the server. When using Q2QConnect,
make sure the path used to get to QuickBooks is the same. Q2QConnect validates the path and
filename to ensure the correct QuickBooks file is synced.

In Q2QConnect, verify the company file path by clicking Settings > Database Connections.

In QuickBooks, verify the company file path by clicking File > Open Previous Company. Both
paths and should match.

Note: If you find the paths are different, open the QuickBooks file using the same path as listed

in Q2QConnect. This can happen when the QuickBooks file is upgraded and the file is opened
through another path.
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Should | include my chart of accounts account number when specifying expense accounts to
sync?

In QuickBooks the account name and account number are two separate fields. If you are
syncing the expense side of transactions to QuickBooks, only use the account name; not the
account name and number.

How should | indicate sub accounts when specifying expense accounts to sync?
If you are syncing the expense side of bills to QuickBooks, use the full account name. le. if the
account is a sub-account on the chart of accounts, then concatenate the parent account and

w,n

sub-account with a colon (“:”) and no spaces.

Example: Professional Fees:Accounting

How should | indicate sub customers (aka “Jobs”) when syncing customer:job names?
If you are syncing Customers that have Jobs and you are syncing the whole job name,

“w.n

concatenate the customer name and job name separated by a colon (“:”) and no spaces.

Example: ABC Company:Job 1234
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Minimum System Requirements
The following system requirements must be met for a successful install and use of Q2QConnect.

Minimum requirement

Processor Intel® or AMD processor; 2 GHz or faster processor
Operating Microsoft 8.1, 10 or Windows 11. Current version of QuickBooks (2022)
system will not install on Windows 7.

For server installations: Windows Server 2008 R2 SP1 and Higher
(Windows Server 2012, 2016, or 2019 preferred).

Q2QcConnect is not compatible with Mac OS.

RAM 1 GB or more of RAM (8 GB recommended). More RAM may be required
for larger Quickbase applications. For example, performance testing
found that evaluating a customer list with 44,400 records required
450MB of RAM.

Hard disk space = 100 MB or more of available hard-disk space (includes installation of the
QuickBooks Desktop SDK, aka QBFC13).

Internet Internet connection required for software activation, connection to
Quickbase, and transfer of data to QuickBooks Desktop.

QuickBooks QuickBooks Desktop 2015/15.0 or higher (Pro, Premier, or Enterprise
Version Solutions). Current version recommended. QuickBooks Online and
QuickBooks for Mac not supported.

Admin Rights Admin rights on local installation computer required, as well as modify
access to installation folders, subfolders, and files (c:\varcsolutions\)

When setting up Q2QConnect, the initial connection to your Quickbase

application must be done by an admin user with full access to all tables
and fields.
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Troubleshooting

The following are problems you may encounter and our recommended solution. If you
encounter a problem not listed here, please call us at: 281-412-6914.

Installation Problems

Can’t install Q2QConnect as a non-admin computer user

The most common problem we see is an error during install. This is usually the result of
insufficient privileges on the installation computer. Make sure you are installing the program as
an Admin user with modify rights to the installation folder, subfolder, and files.

Installing QuickBooks Desktop SDK AFTER Q2QConnect Install

For proper install and operation of Q2QConnect, the QuickBooks Desktop SDK (aka QBFC13)
must be installed PRIOR to installing Q2QConnect. If necessary, uninstall Q2QConnect, install
QBFC13, then reinstall Q2QConnect.

Q2Q Connect Doesn’t Support Quickbase 2 Step Authentication

2 Step Authentication must be disabled in your realm/policy or account settings for
Q2QConnect to connect with Quickbase. Learn how to enable/disable here:
https://help.quickbase.com/user-assistance/two_step_auth.html/

Mapping Problems

When mapping fields in Q2Q, sometimes the fields don’t show below. What's the resolution?
If you select a table and the fields do not show below, click on another table name then back to
the desired table and the fields should populate.
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Q2QConnect Operation Problems

Why can’t | create a connection to QuickBooks?

QuickBooks should be open prior to connecting Q2QConnect. Also, review your connection
settings under Settings > Database Connections. If you have specified an Open Mode of Multi-
User for QuickBooks, make sure you are logged into QuickBooks and toggled into Multi-User
Mode (QuickBooks: File > Switch to Multi-User Mode). The modes need to be the same
between Q2QConnect and QuickBooks.

Database Connection Settings

QuickBooks

Q:\A2Q Data Files\Q2Q Lamys Landscaping. QBW ‘

QuickBooks Company File Path
QuickBooks Company Name |Q2G - Lamy’s Landscaping | | Test Connection |

Corecton Type [1oca__v] [Boen Wode Dbt +]]

QuickBooks Mode:

Q2Q - Lamry’s Landscaping - Intuit QuickBooks Enterprise Solutions: Accountant 20 ){multi-user)(Admin)

File Edit View Lists Favorites Accountant Company Customers Vendors Employees Inventory Banking Reports Window Help (U

Income Tracker Bill Tracker Calendar Snapshots Customers \Vendors _ I—'

Why can’t | access the Q2QConnect Settings? (Multi-user Configurations)
In a multi-user configuration, the global settings file is shared by all licensed users. If a user is

currently editing the settings, other uses are not able to edit the settings.
Q2QConnect 7]

Could not open the global settings file G:\Q2Q Data Files\00 Q20Q
Config File\Q2Qsettings.config
because it is currently opened by another user.

]
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A Quickbase application user or password change is causing a “Connection to QuickBase

failed” error message.

If the user name or password in Q2QConnect refers to a user id/pw that has been changed in

your Quickbase application, you need to update that authentication information in
Q2QConnect using the following instructions.

Quickbase Connection Error Message-Popup

VARC Solutions

n Welrome GreenStandards (iliy

ot Connection Settings -0 X
() Single-user (® Multiuser  Corfig File Path |Q:\QEData\G2QSEﬂings.mnﬁg ||:|
Connection I_ wl Wil i | [ (el e |
QuickBase Connection 28

I Q) @ Connection to QuickBase failed.

[ memes S ew w0 mainTact=AP|_Authenticate;
QUICK Sorry! Something's wrong with your sign-in info. Try again.

)

Quickbase Connection Error Message-Status Bar

Select All | Unselect All

|| From [i0212022 B[ [117 7200 @-

View

| Customer Search |

Base: Failedk hittps:/) |_GetDBInfo: Sormy! Samething's wrong with your sign-in info. Try again.

E ‘Q2QConnect -3 X
File Settings Help

¢  ® & | B| & 0 % 5 ]

Connect Customers Vendors | Invoices Cr Bille
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Modify Connection Settings
1. Open Q2QConnect
2. Click Connect (and select specific connection if applicable).
3. Click Settings > Database Connections for the current connection.
4. Click Modify at the top of the window.

[*}] Connection Settings = X
© Singleuser () Multiuser  Config File Path C:\VARC Solutions\Q2QConnect\Q2Q Settings cc
Connection  Main Modify Copy New
Set as Default Delete Add New

5. In the Modify Connection window, update the Email Address or Screen Name and
Password as appropriate.

6. Click Connect to QuickBase.
7. Select your Quickbase application from the list.
8. Click Test Connection.

E_] Modify Connection = X
Connection Name [Mair|
Q) Realm = === quickbase com
' Email Address or Screen Name
o U l C K llllllllllll
BACIE Password
Connect to QuickBase
Connect and " 1
Select Your QuickBase | /==
for Enter it below) : Tl |
|- m - h
| m B )
Quick Base Application Name Lan_?"s Landsce_;ging__
Application Token M - of il s e < 7
9. Click OK.

10. Click Save Connection.
11. Click Close in the Connection Settings window.
12. Retry your Q2QConnect connection as normal.
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Payments are not applying to open customer invoices
When sending payments, if the date of the invoice to apply the payment to is outside of the
invoice date range in the transaction filters it will not apply.

€ Transaction Filters

Lse these settings to reduce the amount of transactional data read from Guick Base
Fixed Start Date Fixed No. of Months Fixed Start Date Fixed No. of Months
Estimates [« i = Sales Orders [« B =
Invoices @] | 1/ 1/2020 | [+ ] ‘1 E” Invoice Paid Status [« B =
Credit Memos o1 Payments @ | 3/ 172024 B~ op E
Purchase Orders o =
Invoice 'C343" not found (or already paid).
Bills ; dy paid). ofi E
Would you like to apply this payment to open invoices?
Or just put the amount on the customer’s account?
Bill Credits
Apply On Account
Credit Card Charges [« N =
Timesheets o =
Cancel Save & Close

To resolve this issue, expand the invoice transaction filter to include the date of the invoice.
Sync again and Q2QConnect will find and apply the payment to the proper invoice.
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Release Notes

The following table lists each software release and what changed. We are actively testing and
developing New/Improved Features and fixing bugs when discovered. (* indicates additional
license fees may apply).

Version | Release Date| Release Notes |

3.35 04/07/2024 | Improved Installation Process to make installation and updates easier.

Resolved issue with Paid Status and Date Paid reversed mapping.

Resolved several "under the hood" issues with invoice numbering, transferring of
"Site" information on invoices, bill and invoice Due Dates.

Resolved an issue preventing Credit Memos from syncing when "Allow Updates" is
unchecked.

Improved Sync Processing time related to Sync Error notifications. Instead of
prompting a user to click "OK" for each transaction sync error, the sync process will
continue. User is presented with a sync summary at the end with number of
successful and number of errors as applicable. Transactions not successfully synced
will remain in Q2QConnect window for review.

3.31.99 | 08/24/2023 | Updated SSL Cert on Executable to resolve “Revoked SSL” Issue with QuickBooks
desktop 3rd party apps.

3.31 09/09/2022 | Improvement of Multi-User Licensing process*

Improvement of Multi-QB File feature when switching between QB Files or
Quickbase accounts*

Invoice Paid Status and Bill Paid Status updates now ignores “ok to send” setting in
Quickbase.

3.29 07/13/2022 | Improvement of Multi-User and Multi-QB File Configuration Settings*
Added ability to change column display width of all fields in Q2QConnect
Additional under-the-hood improvements for sync speed and error handling

3.28 02/08/2022 | Improvements to Multi-User setup*

Added the ability to export/import Q2QConnect configuration settings
Added Multi-QB File Configuration Capability*

Fixed bug related to QuickBooks default values

Fixed bug related to entries incorrectly showing as changed

3.27 06/14/2021 | Improvements to sync of billable line items for Bills, Bill Credits, Credit Card
Charges, and Credit Card Credits

3.24 06/05/2020 | Added Multi User Configuration for Local Machine or Hosting Machine*

Added Terms and FOB fields to Purchase Orders

Added Due Date field to Estimates

Added New Transactions: Bill Credit, Credit Card Charge, Credit Card Credit, Invoice
Paid Status, Bill Paid Status

Added Due Date and Currency fields to Sales Orders

Added Currency field to Invoices

Added CC Email Address to Customers, Jobs (2nd level customers), and Vendors
Fixed a bug where Estimate Ship To Addresses were being overwritten even if the
fields were not mapped

Solved an issue where Sync ID on Payments not coming over consistently
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Add the ability to use a “-“ character in transaction numbering (e.g. ABC-123)
Added CC Email Address to Customers, Jobs (e.g. 2nd level customers), and
Vendors

3.19 03/17/2019 | Fixed OK To Send on Single Level Customers.

3.18 02/25/2019 | Added Currency and Exchange Rate on Customers, Vendors, and Bills

3.16 2/8/2019 Added/Fixed sync of Currency & Exchange Rate after updating Invoices exchange
rate in QuickBooks.

3.15 12/20/2018 | Fixed intermittent crashing issues when syncing Bills with multiple customer lines
included in sync. Fixed Payments not updating Q2Q ListID in Quickbase.

3.10 8/21/2017 | Added Sync for Date Paid, Amount Paid on Invoices, Credit Memos, and Bills.
Added Purchase Order Template mapping.

3.09 6/28/2017 | Added Search for Estimates, Sales Orders, Credit Memos, Payments, Purchase
Orders, Receipts, Bills. Note: Search not available on lists or Timesheets

3.07 6/12/2017 | Added Sync Back to Base for all transactions, based on Qty change.
Payments Sync Back if deleted from Books

3.06 4/11/2017 | Added Invoice Sync Back to Base

3.04 4/2/2017 Added List Filters for Active/Inactive
Fixed Invoice paid status for line-item detail
Added Payments Sync

3.03 3/31/2017 | Added Items Sync for the Preferred Vendor and Manufacturer’s Part Number
fields.
Added Invoice Paid Status

3.01 3/25/2017 | Added Customer Name search on Customers screen and Invoices Screen

Added Line Item Sync for Invoices and Credit Memos
Added paid status for Invoices and Credit Memos

Revision: 3.35, 04/07/2024
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